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Contents at a glance
This user’s manual contains the information you need to efficiently use
ASUS® MyPal A716 Pocket PC.

• Chapter 1 - Get started! .............................................................. 1-1

This chapter introduces the ASUS MyPal A716 Pocket PC, how to
set and power it up, and basic screens that will familiarize you with
its many features.

• Chapter 2 - Learn the basics ..................................................... 2-1
This chapter will teach you the basic functions in MyPal A716. You will
learn how to enter, find, and organize information, customize the
device, and use the bundled ASUS utilities.

• Chapter 3 - Microsoft® ActiveSync® ........................................... 3-1
This chapter tells you how to use the Microsoft® ActiveSync® to
synchronize your device with your desktop computer.

• Chapter 4 - Microsoft® Pocket Outlook ..................................... 4-1
This chapter details the procedures for the Microsoft® Pocket Outlook
Calendar, Contacts, Tasks, Notes, and Inbox.

• Chapter 5 - Companion programs ............................................. 5-1

This chapter includes information on Pocket Word, Pocket Excel,
MSN Messenger, Windows Media Player for Pocket PC, and
Microsoft Reader.

• Chapter 6 - Pocket Internet Explorer ......................................... 6-1
This chapter gives information on using Pocket Internet Explorer,
Mobile Favorites folder, and AvantGo interactive service.

• Chapter 7 - Get connected ......................................................... 7-1
This chapter provides the procedures for connecting to the Internet,
and for transferring data using infrared (IR).

• Chapter 8 - Bluetooth® ................................................................................................... 8-1
This chapter provides information on using the Bluetooth feature
built-in the device.

• Chapter 9 - Wireless LAN........................................................... 9-1

This chapter provides information on launching and using the
Wireless LAN feature of your device.

• Appendix - Notices ..................................................................... A-1
This part includes the safety notices and regulations.
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MyPal A716 specifications

MyPal A716 package
Your package includes several accessories for the Pocket PC. After
unpacking, check the items against the list below and make sure that they
are in good condition. If any item is missing or damaged, contact your
dealer or retailer immediately.

** English version keyboard. Visit the ASUS website to check the availability of other language version keyboards.

Standard package contents

• ASUS MyPal A716
• USB cradle
• USB sync cable
• AC adapter/power cord

     Input: 100V~240V
     Output: 5V 2.4A 10W

• Stylus
• Microsoft Companion CD
• Bonus CD
• User’s Manual
• Quick Start Guide
• Warranty card

Optional accessories

• Stylus
• Car charger
• Foldable keyboard**
• Leather handheld case
• Traveling USB sync cable
• AC adapter/power cord  (UL/CEE/UK/SAA/CCEE)
• GPS mouse
• CF GPS card
• CF FM radio card
• CF camera card
• Bluetooth GPS
• 3000 mAH Lithium Ion battery

Processor

Operating system

Memory

Display

Removable battery

Card slot

Connection

Audio

Size

Weight

Intel® PXA255 400 MHz

Microsoft® Windows Mobile™ 2003

64MB Flash
64MB SDRAM (55MB /53MB user accessible for Western/

     Eastern languages, respectively)

3.5-inch, brilliant transflective TFT LCD
65,536 colors, 240x320 resolution

1500 mAH Lithium Ion
Up to 19-hour battery life*

CF card slot, SD card slot

Wireless LAN (802.11b)
Bluetooth®

FIR: 4Mbps, SIR: 115.2Kbps

3.5mm stereo headphone jack
Built-in microphone and speaker

138mm x 78mm x 17.6mm (L x W x H)
5.43in. x 3.07in. x 0.69in.  (L x W x H)

197g

* According to Microsoft Logo Test Kit - Battery Life Test
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Introducing MyPal
The ASUS® MyPal A716 is truly a good companion wherever you go.
Powered by a 400MHz Intel® PXA255 processor, equipped with 64MB
SDRAM and 64MB Flash ROM, and bundled with the Microsoft® Windows
Mobile® 2003 plus a host of useful utilities, you have everything you need
in your pocket!

Front features

• Power LED - blinks green when the battery is charging; steady green
when the battery is fully charged and the device is connected to an AC
power source.

• Bluetooth/Wireless LAN LED - lights up blue when either Bluetooth™
or Wireless LAN feature is ON.

• Wireless antenna - allows you to obtain signal and use the wireless LAN
feature.

LCD touch screen

Navigation button

Tasks button

Contacts button

ASUS Launcher button

Calendar button

Speaker

Power button/
Backlight button

Wireless antenna
Bluetooth/Wireless LAN LED

Power LED
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• Power/Backlight button - turns the device power on or off if you press
the button quickly. Pressing and holding the button for a few seconds
turns the backlight on or off. Turning off the backlight saves battery
power.

NOTE Press this button and the Tasks button simultaneously if you
wish to launch the Align Screen function.

• LCD touch screen - allows you to enter, read, send, receive, or edit data
by tapping on it. The screen lumination is increased or decreased by
changing the backlight settings.

• ASUS Launcher, Calendar, Tasks, and Contacts buttons - allow you
quick access to commonly used programs.

• Navigation button - functions like the four arrow keys and the Enter key
on a keyboard. This multifunction button allows you to:

- move through the program icons, folders, or files in a menu by
scrolling up or down

- launch a selected program, list folder contents, or open a file by
pressing the center of the button

• Speaker - allows you to hear alarms and other sound outputs from the
device.



1-4 Chapter 1

Side features

• Power connector - connects the AC adapter cable. Use this connector if
you wish to use AC power without the cradle.

• Enter button - executes the selected application icon or command.

• Back button - selects the previous application icon or command. This
button functions like the left arrow on the navigation button.

• Next button - selects the next application icon or command. This button
functions like the right arrow on the navigation button.

• Reset switch - allows you to perform a soft reset in case the device
malfunctions, or when an application hangs. Press the tip of the stylus on
the switch to reset the system.

• Infrared (IR) port - allows you to copy or send data to another device
that has an IR port.

• Battery latch - secures the battery to the unit.

Left side Right side

Enter button

Back button

Infrared (IR) port

Reset switch

Next button

Power connector

Battery latch
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Top features

Bottom features

• CF card eject button - releases the CF card from the slot.

• CF card slot - accommodates a CompactFlash (CF) card.

• Headphone jack - connects a headphone.

• SD card slot - accommodates an SD card.

• Stylus - used for tapping or writing on the LCD touch screen. Slide out
the stylus from its compartment. Refer to the description of the stylus on
the next page.

• Cradle connector / Sync cable connector - connects to the 26-pin
female connector on the cradle. If you are not using the cradle, connect
the 26-pin USB sync cable directly to this connector to synchronize your
device with your computer.

• Built-in microphone - magnifies your sound recording.

Cradle connector /
Sync cable connector

Built-in microphone

Stylus

CF card slot

Headphone jack SD card slot

CF card eject button
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Back features
The device has a removable external battery secured by a latch. If you
wish to remove the battery, use the stylus to slide the latch toward the
unlocked icon, then slide the battery downward.

Without the battery, the back of the device
appears as shown.

In addition to the external battery, the
device includes a built-in backup battery.
The backup battery contains a copy of
your operating system settings.

The backup battery has an ON/OFF
switch. The default setting is ON for
normal operation. Slide the switch to OFF
only if you wish perform a hardware reset.
CAUTION! A hardware reset erases all of
your data!

NOTE As a precaution, the power button is automatically disabled
when you unlock the battery latch. You may only turn on the
power when the battery is securely locked to the unit.

External battery

Locked icon

Unlocked icon
Battery latch

Switch for backup battery
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The cradle
The cradle has three connectors.

• Device connector - holds the device in place. This is a 26-pin connector
that matches the connector on the bottom of the device.

• USB connector - synchronizes the device with your PC.

NOTE The USB cable/connector is not detachable from the back of
the cradle.

• Power connector - connects the bundled AC adapter. This connector is
located at the back side of the cradle.

Device connector

USB connector

Power connector

The stylus
The stylus functions on a Pocket PC the same way a mouse functions on
a standard PC. Use the stylus to tap or drag on the LCD touch screen to
open programs or execute commands.

• Tap. Touch the screen once with the stylus to open programs and select
options.

• Drag. Hold the stylus on the screen and drag across the screen to select
text and images. Drag in a list to select multiple items.

• Tap and hold. Tap and hold the stylus on an item to see a list of actions
available for that item. On the displayed pop-up menu, tap the action that
you want to perform.
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Setting up MyPal

Placing on the cradle
Position the device on the cradle as shown. Match the connectors and
carefully insert the device until it fits in place.

Connecting the AC adapter
• Connect the AC adapter cable to the connector at the back of the cradle.

Connect the power plug to a grounded wall socket. See Figure 1.

• If you are not using the cradle, connect the AC adpater cable directly to
the power connector at the bottom of the device. Connect the power plug
to a grounded wall socket. See Figure 2.

Figure 1

Figure 2
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Charging the battery
Your device includes a rechargeable Lithium
Ion battery. You must charge the battery
before using the device the first time. The
battery starts charging as soon as you
connect the AC adapter to a power source.
Use the AC adapter to plug your device to a
power source whenever possible, especially
when you are using a modem or other
peripherals, using the device backlight,
connecting to a PC, or letting notification
light flash for extended time periods.

To display the power status, tap  ,
Settings, System tab, and the Power icon.

Activating MyPal
It is important that you properly calibrate and activate your device before
using it. This process ensures accurate positioning when entering text and
selecting menus.

Follow these steps to calibrate and activate MyPal.

1. Press the power button.

2. Use the stylus to tap the LCD touch screen to start the calibration and
activation.

3. At the prompt to align the screen, tap the center of the cross whenever
the travelling cross stops on the screen. You may have to do this step
several times to properly calibrate.

4. When done with the screen calibration, follow the screen instructions to
complete the activation.

• at the “Stylus” screen, tap Next to continue.

• at the “Pop-up menus” screens, perform the indicated operations.

• at the “Congratulations” screen, tap Next to continue.

• at the “Location” screen, select your time zone and tap Next to
continue.

• at the “Completion” screen, tap the screen to continue.

5. When the Today screen appears, MyPal is ready to use. Proceed to
the next section for information on the basic screens on your device.
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Basic screens on MyPal

Today screen
Normally, the Today screen appears when you turn on your device for the
first time each day.

NOTE When the device is already on and the screen displays
another program, you can display the Today screen by

tapping the  icon. Then from the Navigation bar, tap
Today.

As shown in the sample below, the Today screen lets you see at a glance
the summary of the important information for the day.

From the Today screen, tap any of the listed items with the stylus to
display the details. See “Chapter 2: Learn the basics” to learn how to
modify the current tasks or activities, or to add new items or information.

Tap to switch
to a program

Tap to set up or change network or modem connections
Tap to change volume or mute all sounds

Tap to display the date, time,
and your next appointment

Tap to change the date and time

Your day at a glance

Tap to display the Bluetooth menuTap to create a new item

Tap to view PC connection status

Tap to display the Wireless LAN menu
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Start menu
From the Start menu, you can select programs, settings, and Help topics.

To display the Start menu, tap the  icon from the top of the screen.

Icon Program Description

ActiveSync Synchronize information between your
device and your desktop computer.

Calendar Keep track of your appointments and create
meeting requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive e-mail messages.

Internet Explorer Browse Web and WAP sites, and download
new programs and files from the Internet.

Notes Create handwritten or typed notes, drawings,
and recordings.

Tasks Keep track of your tasks.

Programs Tap to see additional programs installed in
your device.

Settings Tap to see items that you can customize or
adjust to your preference.

Find Tap to find data in your device.

Help Tap to see the Help contents.

Tap to open a recently used program

Tap to open a program

Tap to open the Programs menu

Tap to open the Settings menu

Tap to display the Help topics
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Command bar
At the bottom of the screen is the Command bar. You can use the menus
and buttons on the Command bar to perform tasks in programs.

NOTE The menus and buttons vary depending on the programs you
are using.

Tap to select menu
commands

Tap to select
button commands

Tap to display
the input panel

Pop-up menus
With the pop-up menus, you can easily choose an action for an item.

For example, you can use the pop-up menu in Tasks to delete, copy, or
beam a task. The actions in the pop-up menus vary from program to
program. To access a pop-up menu, tap and hold the stylus on the item
that you wish to perform action on. When the menu appears, lift the stylus,
and tap the action that you want to execute. To close the pop-up menu
without performing an action, tap anywhere outside the menu.

Tap and hold until the pop-up menu appears

Tap the action that you wish to perform

Tap outside the pop-up menu to close it
without performing an action
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Tap and hold until the pop-up menu appears

Tap the action that you wish to perform

Tap outside the pop-up menu to close it
without performing an action

The pop-up menus are also available in most other programs in your
device. The pop-up menu items vary depending on the program or
application. For example, the File Explorer pop-up menu includes more
items than in Tasks.
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Additional storage
Your device comes with two kinds of memory card slots for additional
storage. The CF card slot supports the multimedia cards listed under
“Optional Accessories” on page iv of this manual. The SD card slot
supports the SecureDigital memory card.

NOTE Install an SD card or CF card if you wish to use the ASUS
backup features.

NOTE An SD card fits only in one orientation, and slides smoothly
into the slot if inserted correctly. DO NOT force the SD card
into the slot!

2. Push the card all the way into the slot until it fits completely. If properly
installed, the SD card edge aligns with the top edge of the device.

Installing and removing an SD card

To install an SD card:

1. With the label side (usually the side with the card manufacturer’s
name) face up, and the bar code/serial number side face down, insert
the card into the SD slot.

Label side

To remove an SD card:

Press the card slightly until it ejects.
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NOTE A CF card fits only in one orientation, and slides smoothly into
the slot if inserted correctly. DO NOT force the CF card into
the slot!

Label side

Installing and removing a CF card

To install a CF card:

1. Locate the card side with the 50-pin female connector and insert into
the slot. The label side (usually the side with the card manufacturer’s
name) face up, and the bar code/serial number side face down.

2. Push the card all the way into the slot until it fits completely. If properly
installed, the CF card edge aligns with the top edge of the device.
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To remove a CF card:

1. Press the CF card eject button
unti it pops out. (This button is
normally pressed in and aligns
with the top of the device.)

Button is pressed in

Button popped out

2. When the button has popped out,
press it in again to release the CF
card. (The button goes back to its
“pressed in” position.)

3. Slide out the CF card.



Learn the basics 2-1

Chapter 2

Learn the basics

♦♦♦♦♦ Entering information ............................................ 2-2
Entering text using the Input Panel .......................................... 2-2
Writing on the screen ............................................................... 2-5
Drawing on the screen ............................................................. 2-8
Recording a message .............................................................. 2-9
Using a preset message ........................................................ 2-10

♦♦♦♦♦ Finding and organizing information ..................2-11
Using the File Explorer ........................................................... 2-12

♦♦♦♦♦ Customizing your device ................................... 2-13
Adjusting settings ................................................................... 2-13
Selecting sounds and notifications ......................................... 2-15
Using AsusLauncher .............................................................. 2-16
Adding or removing programs ................................................ 2-20

♦♦♦♦♦ ASUS utilities ...................................................... 2-23
ASUS Backup ........................................................................ 2-23
ASUS Settings ....................................................................... 2-29

♦♦♦♦♦ Bundled programs.............................................. 2-33
ASUS Programs ..................................................................... 2-33
Games ................................................................................... 2-33
Calculator ............................................................................... 2-34
File Explorer ........................................................................... 2-34
Microsoft Reader .................................................................... 2-34
MSN Messenger .................................................................... 2-35
Pocket MSN ........................................................................... 2-35
Pocket Word .......................................................................... 2-35
Pocket Excel .......................................................................... 2-36
Pictures .................................................................................. 2-36
Terminal Services Client ........................................................ 2-36



2-2 Chapter 2

Entering information
You can enter information in your device in any of the following ways.

• Use the input panel to enter text using the soft keyboard or the Letter
Recognizer

• Write directly on the screen with the stylus

• Draw pictures on the screen

• Speak into the device microphone to record a message

• Use the Microsoft® ActiveSync® to synchronize or copy information from
your desktop computer to your device

Entering text using the Input Panel
Use the Input Panel to enter information in any program on your device.
you can either type using the soft keyboard or write using the Letter
Recognizer, Block Recognizer, or Transcriber. In either case, the
characters appear as typed text on the screen.

To show or hide the input panel, tap the Input Panel button. Tap the arrow
next to the Input Panel button to see your options.

To type with the soft keyboard:

1. Tap the arrow next to the Input Panel button, then tap Keyboard.

NOTE To demonstrate, open Notes.

2. Tap the keys with the stylus to enter information.

Select an input method

Tap to show or hide the input panel

Tap to display the input method options
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When you use the Input Panel and the soft keyboard, your device
anticipates the word you are typing and displays it above the Input Panel.
When you tap the displayed word, it is inserted into your text at the
insertion point. The more your use your device, the more words it learns to
anticipate.

NOTE To change options on word completion feature:

1. Tap   .
2. Tap Settings.
3. Tap Personal tab.
4. Tap Input.
5. Tap Word Completion tab.
6. Make your desired changes.

To use Letter Recognizer:

With the Letter Recognizer, you can write letters on the screen with the
stylus as you would on paper.

1. Tap the arrow next to the Input Panel button, then tap Letter
Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted to a typed text that appears on
the screen. For instructions and demonstation on using the Letter
Recognizer, tap the question mark next to the writing area.

Tap here if this is the word you wish to use



2-4 Chapter 2

To use Block Recognizer:

With the Block Recognizer, you can input character strokes that are similar
to those use on other devices.

1. Tap the arrow next to the Input Panel button, then tap Block
Recognizer.

2. Write a letter in the box.

When you write a letter, it is converted to a typed text that appears on
the screen. For instructions and demonstation on using the Block
Recognizer, tap the question mark next to the writing area.

To use Transcriber:

With Transcriber, you can use the stylus to write anywhere on the screen
as you would on paper. Unlike Letter Recognizer and Block Recognizer,
you can write a sentence or additional information. Pause after writing and
let Transcriber convert the written characters to typed characters.

1. Tap the arrow next to the Input Panel button, then tap Transcriber.

2. Write anywhere on the screen.

For instructions and demonstration on using Transcriber, with
Transcriber open, tap the question mark in the lower right corner of
the screen.

To edit typed text:

1. Select the text that you wish to edit using either one of the following:

• drag the stylus over the text
• tap twice to select a word
• tap three times to select a paragraph

2. Tap Edit on the Command bar and select an action, or use one of the
tools in the Input Panel to enter a new text.
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Writing on the screen
In any program that accepts writing, such as the Notes program, and in the
Notes tab in Calendar, Contacts, and Tasks, you can use the stylus to
write directly on the screen. Write the way you do on paper. You can edit
and format what you have written and convert the information to text at a
later time.

To write on the screen:

1. Open the Notes program.

2. Tap the Pen button to switch to the writing mode. The screen displays
blank space with lines to help you write.

3. Write your text.

NOTE Some programs that accept writing may not have the Pen
button. See the documentation for that program to find out
how to switch to writing mode.

Tap the Pen button and use
your stylus like a pen
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To edit your writing:

1. Tap and hold the stylus next to the text that you wish to select until the
insertion point appears.

2. Without lifting, drag the stylus across the text to select it.

If you accidentally write on the screen, tap Tools, then Undo and try
again. You can also select text by tapping the Pen button to deselect it,
then dragging the stylus across the screen.

3. Tap Edit on the Command bar and select an action, or use one of the
tools in the Input Panel to enter a new text.

To convert writing to text:

• Tap Tools, then Recognize.

To select a zoom level:

• Tap Tools, then tap a zoom percentage from the options.

The writing is turned into text
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If the conversion is incorrect, you can select different words from a list of
alternates or return to the original writing.

1. Tap and hold the incorrect word.

2. When the pop-up menu appears, tap Alternates to display a list of
alternate words for the selection.

3. Tap the word that you want to use, or tap the writing at the top of the
menu to return to the original writing.

Tips for getting good writing recognition

• Write neatly.

• Write on the line and draw descenders below the line. Write the cross of
the “t” and apostrophes below the top line so that they are not confused
with the word above. Write periods and commas above the line.

• For better recognition, try increasing the zoom level to 300% using the
Tools menu.

• Write the letters of a word closely and leave big gaps between words so
that the device can easily tell where the words begin and end.

• Hyphenated words, foreign words that use special characters such as
accents, and some punctuation cannot be converted.

• If you add writing to a word to change it after the word has been
recognized, the writing that you added will be included when you try to
recognize the writing again.

Tap to return to your
original writing

Or, tap the word that
you want to use
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Drawing on the screen
You can draw on the screen in the same way that you write on the screen.
The difference between writing and drawing on the screen is how you
select items and how they can be edited. For example, selected drawings
can be resized, while writing cannot.

To create a drawing:

1. Use the stylus to make a stroke three ruled lines high. A dotted box
appears.

2. Make your drawing in or touching the drawing box and crossing three
ruled lines. If the drawing does not cross three lines, it changes to writing.

NOTE To easily work on or view your drawing, change the zoom
level by tapping Tools and selecting your desired zoom.

To edit your drawing:

1. Tap and hold the stylus on the drawing until the selection handle
appears. To select multiple drawings, deselect the Pen button, then
drag to select the drawings you want.

2. Tap and hold the selected drawing, then tap an editing command on
the pop-up menu or tap a command on the Edit menu.

3. Resize the drawing by deselecting the Pen button (if selected) and
dragging a selection handle to your desired size.

The drawing box indicates the
boundaries of the drawing

Pen button
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Recording a message
In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts, you can include a recording
in the Notes tab. In the Notes program, you can either create a stand-
alone recording or include a recording in a written note. If you want to
include the recording in a note, open the note first. In the Inbox program,
you can add a recording to an e-mail message.

To create a recording:

1. Tap  , then tap Notes,.

OR

Tap New, then Note.

2. Tap the Record icon from the command bar to display the recording
toolbar.

3. Tap the Record button (red button) to begin recording.

4. Hold your device with the microphone near your mouth or other source
of sound.

5. To stop recording, tap the Record button. You will hear two beeps. The
new recording appears in the Note list, or as an embedded icon.

6. To play the recording, tap it from the list, or if embedded in a note, tap
the speaker icon.

Indicates an embedded
recording

Tap to show or hide the
Recording toolbar

Tap to begin recording



2-10 Chapter 2

Using a preset message
When using Inbox or MSN Messenger, use My Text to quickly insert
preset or frequently used messages into the text entry area. To insert a
message, tap My Text and tap your desired message.

NOTE You can add text after inserting a My Text message.
However, you have to add it before sending the message.

To edit a preset message:

1. Tap Tools, then Edit My Text Messages.

2. Select a message and make your desired changes.

To change the recording format:

1. In the note list, tap Tools then
Options.

2. Tap the Global Input Options link.

3. Tap the Options tab.

Mobile Voice is a 2.4KB audio codec.
It is the recommended format because
it provides good voice recording and
less storage space.

Pulse Code Modulation (PCM)
provides slightly better sound quality
but takes up 50 times more storage
space tham Mobile Voice recordings.
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Finding and organizing information
The Find and Help features on your device helps you quickly locate
information.

To find information:

1. Tap  , then tap Find.

2. Enter the text that you want to find, select a data type, then tap Go to
start the search. To quickly find information that is taking up space on
your device, select Larger than 64 KB in Type.

Type a word to find

Tap to search for the word

Topics found containing
the searched word

To use the Help feature:

1. Tap  , then tap Help.

2. Tap a link to the topic that you wish to
display.
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Using the File Explorer

To use the File Explorer to find and organize files:

1. Tap  , then tap Programs.

2. In the Program screen, tap the File Explorer icon to display the files in
your device.

Tap to select a sort order

Tap to display sort options

Tap to display the contents of My Documents folder

Tap to display the contents of the
Flash disk or the storage card

Tap to open a path to a network
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Customizing your device
You can customize your device by adjusting the settings, using the built-in
programs, and installing additional software.

Adjusting settings
You can adjust the device settings to your preference.

To see the available options:

1. Tap  , then tap Settings to display the Settings screen.

2. Tap the Personal or System tab on the bottom of the screen.

You may want to adjust any one of the following items.

• Clock. Change the time or set alarms.

• Menus. Customize what appears on the  menu, and enable a pop-up
menu from the New button.

• Owner information. Enter your contact information.

• Password. Add security to your device.

• Power. Display the remaining battery power indicated by a bar chart.

• Today. Customize the look and information displayed on the Today
screen.

NOTE Refer to the section “ASUS utilities” later in this chapter for
details on the bundled ASUS programs.
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To change the date and time settings:

1. Tap Settings, then the System.

2. Tap the Clock icon.

3. Make your desired settings.

Tap to select a time zone

Highlight a Time item then
tap up or down arrow to set

Tap this down arrow to
display the Calendar

To change the alarm settings:

1. Tap Settings, then the System.

2. Tap the Clock icon, then the Alarm tab.

3. Make your desired settings.

Tap a day of the week for the alarm

Tap and type a description for the alarm

Tap to display the clock and
specify a time for the alarm
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Selecting sounds and notifications
Your device can remind you of things you have to do in several ways. For
example, if you have set up an appointment in Calendar, a task with a due
date, or an alarm in Clock, you will be notified in any of the following ways.

• A message box appears on the screen

• A sound is played (you can select the type of sound)

• A light flashes on the device

To choose the reminder types and sounds:

1. Tap  icon then tap Settings.
2. From the Settings screen, tap the

Sounds and Notifications icon to
display the Volume screen.

3. Adjust the items to your desired
settings.

4. Tap the Notifications tab and set the
event notification details.



2-16 Chapter 2

Using ASUS Launcher
This program allows you the convenience of classifying your frequently
used programs, and quickly launching them with just a few taps.

To access ASUS Launcher:

1. Tap  , then Programs.

2. Tap ASUS Programs, then ASUS Launcher.

NOTE To quickly access ASUS Launcher, press the  button
(leftmost) on your device.

3. From the command bar, tap
Name to display the names of the
existing categories.

The default categories are
Favorites, Start Menu, and
Programs.

4. Tap a category to display the
programs it contains.

By default, the Favorites category
contains the ASUS Launcher and
ASUS Backup program icons.

NOTE You cannot delete the default categories. However, you may
edit the default titles, and add or delete programs contained
in these categories.
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5. Tap Start Menu or Programs to display the default programs in them.

NOTE Whatever category is selected, that category will be launched
the next time you tap the AsusLauncher icon.

To edit the name of a default category:

1. Tap Name, and select a category that you wish to rename. For
example, Programs.

2. Tap Category, then Edit Title.

3. In the Edit Current Category screen, revise the name.

4. Tap OK.
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To customize an existing category:

1. Tap Editor, then Copy To.

2. Tap Name, then Programs (or
Start Menu).

3. In the Programs screen, tap the
program icon that you wish to
copy. For example, Jawbreaker.
A pop-up screen appears.

4. Select a target destination for the
program icon. For example,
Favorites.

5. Repeat steps 3 and 4 to copy
other programs that you wish to
launch often.

6. When done, tap Copy To then
Launch to return to the launch
mode.

7. Tap Name then Favorites to
display your customized quick
launch programs.

8. Tap OK to set Favorites as your
quick launch category.

The next time you access
AsusLauncher, the Favorites
category appears.
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To remove programs from a category:

1. Tap Editor, then Remove.

2. Tap Name, then any of the
existing categories.

3. Tap the program icon that you
wish to remove. For example, the
Calculator icon in the Favorites
screen.

The icon disappears from the
screen as soon as you tap it.

4. When done, tap Remove then
Launch to return to the launch
mode.

5. Tap OK to save your changes.

To add a new category:

1. Tap Category, then Add. A new
category is automatically added.

2. Tap Name to see the updated list
of categories.

3. If you wish to rename the new
category, se page 2-17 for
instructions.
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Adding or removing programs
Programs added to your device at the factory are stored in ROM (Read-
Only Memory). You cannot remove this software, and you will never
accidentally lose ROM contents. ROM programs can be updated using
installation programs with a *.xip extension. All other programs and data
files added to your device after factory installation are stored in RAM
(Random Access Memory).

You can install any program created for your device, as long as it has
enough memory. The most popular place to find software for your device is
on the Pocket PC web site (http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync:

NOTE You need to install the Microsoft ActiveSync on your desktop
computer before you can synchronize and/or add programs
to your device. Refer to “Chapter 3:  Microsoft ActiveSync” for
installation instructions.

1. Determine your device and processor type so that you know which
version of the software to install. Tap  , then tap Settings. On the
System tab, tap About. In the Version tab, take note of the information
in Processor.

2. Download the program to your desktop computer (or insert the CD that
contains the program into your desktop computer). You may see a
single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of
files for different device types and processors. Be sure to select the
program designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation
that comes with the program. Many programs provide special
installation instructions.

4. Connect your device to your desktop computer.
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5. Double-click the *.exe file.

• If the file is an installer, the installation wizard begins. Follow the
directions on the screen. Once the software is installed on your
desktop computer, the installer automatically transfers the software to
your device.

• If the file is not an installer, you will see an error message stating that
the program is valid but it is designed for a different type of computer.
You need to move this file to your device. If you cannot find any
installation instructions for the program in the Read Me file or
documentation, use ActiveSync Explore to copy the program file to
the Program Files folder on your device. For more information on
copying files using ActiveSync, see ActiveSync Help.

6. When the installation is complete, tap  , Programs, and the program
icon to switch to it.

To add a program directly from the Internet:

NOTE You need to be connected to the Internet through an optional
modem card or network card before you can add programs
directly from the Internet.

1. Determine your device and processor type so that you know which
version of the software to install. Tap  , then tap Settings. On the
System tab, tap About. In the Version tab, take note of the information
in Processor.

2. Download the program to your device straight from the Internet using
the Pocket Internet Explorer. You may see a single *.xip, *.exe, or
*.zip file, a Setup.exe file, or several versions of files for different
device types and processors. Be sure to select the program designed
for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or  documentation
that comes with the program. Many programs provide special
installation instructions.

4. Tap the file, such as a *.xip or *.exe file. The installation wizard begins.
Follow the directions on the screen.



2-22 Chapter 2

To add a program to the Start menu:

1. Tap  , tap Settings, tap Menus, tap the Start Menu tab, and tap the
check box for the program. If you do not see the program on the list,
you can either use File Explorer on the device to move the program to
the Start Menu folder, or use ActiveSync on the desktop computer to
create a shortcut to the program and place the shortcut in  the Start
Menu folder.

2. If you are using the File Explorer on the device:

a. Tap  , tap Programs, tap File Explorer, and locate the program
(tap the folder list, labeled My Documents by default, then tap My
Device to see a list of all the folders on the device).

b. Tap and hold the program, then tap Cut on the pop-up menu. Open
the Start Menu folder located in the Windows folder, tap and hold a
blank area of the window, then tap Paste in the pop-up menu.

c. The program now appears on the  menu. For more information on
using the File Explorer, see the section “Finding and organizing
information” earlier in this chapter.

3. If you are using ActiveSync on the desktop computer:

a. Use the Explorer in ActiveSync to explore your device files and locate
the program. Right-click the program, then click Create Shortcut.

b. Move the shortcut to the Start Menu folder in the Windows folder. The
shortcut now appears on the  menu. For more information, see
ActiveSync Help.

To remove a program from the Start menu:

1. Tap  , then tap Settings. On the System tab, tap Remove
Programs.

2. If the program does not appear in the list of installed programs, use
File Explorer on your device to locate the program, tap and hold the
program, then tap Delete on the pop-up menu.
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1. Tap  , then tap Settings.

2. Tap the System tab, then tap the
Memory icon.

3. On the Memory screen, tap the
Running Programs tab.

4. Tap the Stop All button, then tap
OK.

2. Tap  , then tap .

A message appears asking you to
stop other programs before
running the backup utility.

3. Tap OK and stop all running
programs.

To stop all running programs:

ASUS utilities
Besides the Microsoft program that allows you to back up data, your
device also includes proprietary ASUS utilities. The ASUS utilities allow
you to backup or restore data, and adjust settings to customize your
device and maximize its use.

ASUS Backup
The ASUS Backup utility lets you back up your system files and/or data
contained in the main system memory. Unlike the ASUS SmartKeeper
automatic backup feature that backs up the entire system status (system
and data) into one backup file, this utility allows you to manually create
separate backup files for your system files and data files. You may even
categorize the data files and place into different folders.

To access the ASUS backup utility:

1. Tap  , then tap Programs.
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1. Return to the ASUS programs
screen and tap the ASUS
Backup icon.

2. Tap the Backup tab on the ASUS
Backup screen.

3. Tap All Data button to back up all
data on your device.

To back up all data on your device:

4. In the Backup File screen:

• specify a file name for the
backup

• specify the folder in which to
store the backup file (optional)

• select the storage device
(Flash Disk or CF card) where
you wish to save your backup
file

5. Tap OK to start the backup
process.

NOTE You need to insert a CF memory card or an SD card if you
wish to save your backup file into a removable storage
device. Otherwise, you can save the backup file into the
Flash Disk.

NOTE See the online help on your device for online instructions to
back up or restore data.
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6. The screen shows the status of the backup process. When done, a
message appears indicating that the backup is complete, and shows
the total size of the backed up files.

In case the program fails to back up any items, it will show the items on
the screen.

7. Tap OK.

To back up only PIM data on your device:

1. On the ASUS Backup screen, tap
PIM Data button to back up only
the personal information
management (PIM) data on your
device.

2. Select the storage device (Flash
Disk or CF card) where you wish
to save your backup file.

Tapping Cancel returns you to the
previous screen.

3. Tap the Backup tab.
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If you checked the box User
Defined Folders, tap Define to
specify the folders that you wish
to include in the backup file, then
tap OK.

6. Tap Start to begin the backup
process.

7. When the backup process is
complete, the screen displays the
message “Complete” and a list of
all the backed up items.

8. Tap OK.

4. Type a name for your backup file
and the folder where you wish to
place it. You may opt not to
specify a folder.

5. Check the boxes opposite the
items that you wish to back up, or
tap Select All to select all listed
items.
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To restore all data:

1. Tap  , then tap Programs.

NOTE If you saved your backup file into a CF memory card, you
need to insert that CF memory card into the CF slot when
restoring data. Otherwise, you will receive the message “No
storage devices are found!”

2. On the ASUS Programs screen
Tap the ASUS Backup icon.

When prompted, stop all running
programs. See page 2-29 for
instructions.

3. Tap the Restore tab on the ASUS
Backup screen.

4. Tap All Data.

5. In the Backup File screen:

• select the backup file name
(tap the arrow to list down other
backup files, if any)

• select the folder that contains
your backup file (optional)

• select the storage device
(Flash Disk or CF card) where
you stored your backup file

6. Tap OK to start the restore
process.

7. When the restoration is done, a
message appears prompting you
to reset the device.

8. Tap OK to reset.
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1. On the ASUS Backup screen, tap
PIM Data.

2. When prompted, select the
storage device (Flash Disk or CF
card) where you stored your
backup file.

Tapping Cancel returns you to the
previous screen.

3. Tap the Restore tab.

To restore PIM data:

4. Select the backup file name  (tap
the arrow to list down other
backup files, if any).

5. Check the boxes opposite the
items that you wish to restore, or
tap Select All to select all listed
items.

If you checked the box User
Defined Folders, tap Define to
specify the folders that you wish
to restore, then tap OK.

6. Tap Start to begin the restore
process.

7. When the restoration is done, a
message appears prompting you
to reset the device.

8. Tap OK to reset.



Learn the basics 2-29

1. Tap  , then tap Settings.

2. Tap the System tab on the
bottom of the Settings screen.

3. Tap the ASUS Settings icon to
display  the system information
screen. This screen is displayed
whenever you tap the Info tab.

ASUS Settings
The ASUS Settings screen has four parts: Info, Multimedia, System, and
IR. Each part includes items that you can customize.

To display the ASUS settings:

To change the Microphone settings:

Tap the Multimedia tab, then the AGC to
adjust the settings for the microphone
sensitivity. The AGC features allows you
to adjust the recording and environment
noise level.

• The MIC Sensitivity controls the sound
recording input. Setting the slider
toward the “High” sign allows for a
louder recording, but the environment
noise level may be louder also.

• Check the box opposite Automatic to
adjust the recording volume
automatically. To manually adjust the
recording volume, drag the slider toward the “Low” or “High” sign.
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To change the Audio settings:

Tap the Audio tab to adjust the
volume, balance, treble, and bass
settings.

Drag the slider to the left or to the
right until you achieve your desired
sound output.

Tap the Default button to restore the
default audio settings.

1. Tap the Display tab.

2. Set the degree of brightness while
on battery power by dragging the
slider to the left or to the right
until you achieve your desired
brightness.

3. Follow step 2 to set the degree of
brightness when using external
power.

To change the Display settings:

NOTE Using a lower degree of brightness while on battery power
substantially reduces battery power consumption.
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To change the operation Mode:

Tap the Mode tab to display the running
mode of the CPU.

The Turbo Mode allows better CPU
performance. In this mode, the CPU
speed goes up to 400MHz. Set to this
mode when playing games or playing
video. However, setting to Turbo mode
may reduce the battery life.

The Standard Mode allows for up to
300MHz CPU speed. Set to this mode
when listening to MP3 audio files or for
applications  that do not require very fast
CPU speed.

The Power Saving Mode sets the CPU to a fixed speed of 200MHz. Set
to this mode when using text based applications such as Word, Excel, etc.
This mode has a lower CPU performance but extends the battery life.

For automatic power saving, check the box opposite Enable Automatic
Mode. This mode allows for either 200MHz, 300MHz, or 400MHz CPU
speed depending on the program that you are running.

Tap the Autorun tab to select the
source devices to execute the
autorun program.

To select Autorun Devices:
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Tap the Wakeup tab to enable or
disable the wakeup feature. Checking
the box opposite Turn on power
when a program button is pressed
to enable the the feature.

Pressing any one of the function
buttons on the front panel wakes up
the device.

To change the Wakeup sources:

Tap the IR tab to display the
selection. Click FIR for a maximum of
4Mbps transfer rate, or SIR for
115.2Kbps.

To select the transmission rate for infrared (IR):
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Bundled programs
Your device includes the most common Windows programs and more.

To access the bundled programs:

1. Tap  , then tap Programs.

2. Tap any of the icons to launch a
specific application program.

ASUS Programs
Tapping the ASUS Programs icon displays
the ASUS Backup utility,  ASUS Launcher,
and WiFiME program icons.

Tap the ASUS Backup icon if you wish to
use the utility. See section “ASUS
Backup” on page 2-23 for details.

Tap the ASUS Launcher icon to quickly
display your frequently used programs.

Tap the WiFiME icon to launch the
WiFiME program. Refer to the WiFiME
section in “Chapter 9  Wireless LAN.”

Games
Tap the Games icon to display the
available games.
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Calculator
Tap the Calculator icon to use the
calculator.

File Explorer
Tap the File Explorer icon to access
your files. See page 2-12.

Microsoft Reader
Tap the Microsoft Reader icon to
download and read online books.
See Chapter 5.
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MSN Messenger
Tap the MSN Messenger icon to use
the service. See Chapter 5.

Pocket MSN
Tap the Pocket MSN icon to get
connected to the Internet through the
Pocket Internet Explorer. See
Chapter 6.

Pocket Word
Tap the Pocket Word icon to create
Pocket Word documents. See
Chpater 5.
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Pocket Excel
Tap the Pocket Excel icon to create
spreadsheet documents. See
Chapter 5.

Pictures
Tap the Pictures icon to view .jpg
pictures stored on your device or on
a storage card. Refer to the online
help on your device for details on
using this feature.

Terminal Services Client
Tap the Terminal Services Client icon
to connect to a terminal server. Refer
to the online help on your device for
more information.
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Introduction

What is ActiveSync®?
The Microsoft® ActiveSync® is one of the important bundled programs in
MyPal. With ActiveSync, you can synchronize the information on your
desktop computer with the information on your device. Synchronization
compares the data on your device with your desktop computer and
updates both computers with the most recent information.

For example:

• Keep Pocket Outlook data up-to-date by synchronizing your device with
Microsoft Outlook data on your desktop computer.

• Synchronize Microsoft Word and Microsoft Excel files between your
device and desktop computer. Your files are automatically converted to
the correct format.

NOTE By default, ActiveSync does not automatically synchronize all
types of information. Use the ActiveSync options to turn
synchronization on or off for specific information types.

With ActiveSync, you can also:

• Back up and restore your device data

• Copy (rather than synchronize) files between your device and desktop
computer

• Control when synchronization occurs by selecting a synchronization
mode. For example, you can synchronize continually while connected to
your desktop computer or only when you choose to synchronize.

• Select which information types are synchronized and control how much
data is synchronized. For example, you can choose to synchronize your
appointments of the past two weeks only, appointments older than two
weeks are not synchronized.

For more information about using ActiveSync:

1. Start ActiveSync on your desktop computer.

2. From the Activesync menu bar, click Help then on Microsoft
ActiveSync Help.
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Installing ActiveSync®

The ActiveSync program is already installed on your device. To
synchronize information on your device with your computer, you must also
install ActiveSync on your computer. Install ActiveSync from the
Companion CD that came with your product package.

NOTE Before starting the ActiveSync installation, make sure that
you have Microsoft® Outlook® installed on your computer. If
you do not have Outlook, install the Microsoft® Outlook® 2002
from the Companion CD. Even if you have Outlook 98 or
Outlook 2000 installed, you are encouraged to update to
Outlook 2002.

Installing ActiveSync® on your computer

To install ActiveSync on your computer:

1. Turn on your computer and monitor.

NOTE Do not connect your device to your computer until you have
finished installing ActiveSync.

2. Insert the Companion CD into the CD-ROM drive of your computer.
The CD autoruns and displays the initial screen, then the Main Menu
from which you can start the installation.

3. Click on Start Here from the Main Menu.
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4. Read the Overview before
installing ActiveSync 3.7 to make
sure that you perform the
installation sequence correctly.

5. If you have not installed Outlook,
install it now. Click Install
Outlook 2002 and follow the
screen instructions to complete
the installation.

6. Click Download Connection
Wizard and read the overview to
see if you require the wizard.
Follow the screen instructions to
install the wizard on your
computer. Return to the Main
Menu when done.

7. Click Install ActiveSync 3.7,
then click Install.

8. When prompted, select Run this
program from its current
location then click OK.

9. Follow the succeeding screen
instructions. Click Finish to
complete the installation.

10. Restart Windows when prompted,
then proceed to the next section
to connect your device to your
computer and start
synchronization.
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Synchronizing your device

Connecting your device to a computer

To connect your device to your computer:

1. Place the device on the cradle.

2. Connect the AC adapter to the power connector on the cradle.

3. Connect the USB sync cable from the cradle to a USB port on your
computer.

To connect your device to
your computer without
the cradle:

1. Connect flat plug of the
traveling USB sync cable to
the connector at the bottom of
the device.

2. Connect the other end of the
cable to a USB port on your
computer.



3-6 Chapter 3

Setting up a partnership
Immediately after you have completed the installation, the New
Partnership wizard will start automatically to help you establish a
partnership and customize your synchronization settings. At this point, you
can decide exactly which types of information you would like to
synchronize with your computer.

A partnership is a file that allows you to synchronize your device
with your desktop computer. This file is stored on your desktop
computer. An additional file that enables your desktop computer to
recognize your device is stored on your device.

2. On the next screen, select
Synchronize with the desktop
computer. Click Next.

3. Select the type of information that
you wish to synchronize. Click
Next.

OR

If you wish to customize a
synchronized item, highlight the
item then click Settings.

To set up a partnership:

1. When the New Partnership
screen appears, select Standard
partnership for the type of
partnership to establsih between
your device and your computer.
Click Next.
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On the Calendar
Synchronization Settings
window, for example, select from
the options how you wish to
synchronize the appointments on
your device with your computer.
Click OK.

4. Click Finish to complete setting a
partnership.

Immediately after you set up a
partnership, ActiveSync® starts
automatically and initiates the first
synchronization between your
device and your computer.

Refer to the succeeding sections
for more details on
synchronization.
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Checking synchronized information
After your first synchronization, take a look at Calendar, Contacts, and
Tasks on your device. You will notice that the calendar information in
Microsoft Outlook on your computer was copied to your device, and the
information that you have on your device was copied to your computer.

NOTE Open Microsoft Outlook on your desktop computer to see the
details of copied information from your device.
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Manually initiating synchronization
Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your device at any time.

To manually initiate synchronization:

1. Tap  , then tap ActiveSync to display the ActiveSync screen.

2. To start synchronization, make a connection between your device and
your computer, then tap Sync.

To end synchronization, tap Stop.

For more information on synchronization:

Tap   while in the ActiveSync screen, then tap Help.

Connection status
Tap to connect and synchronize
Tap to stop synchronization

Tap to synchronize via IR or
change synchronization settings
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Synchronization options
The Microsoft ActiveSync program allows you to customize your
synchronization settings at any time. You can select the items to
synchronize, set the synchronization schedule, and specify the
synchronization rules.

To display the synchronization options:

• From the ActiveSync window on your desktop computer, click on the
Options icon, or

• From the menu bar, click on Tools, then Options.

1. Check the box opposite the item
that you wish to synchronize.

2. Highlight a checked item then
click on Settings to specify
synchronization options for the
item.

For example, highlight Calendar
then click on Settings to display
the Calendar Synchronization
Settings window. Customize the
available settings, then click OK
when done.

3. Do the same for the other
checked items.

NOTE:  You cannot set the
options for unchecked items.

4. Click OK when done.

To select items to synchronize:
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To set synchronization schedule:

1. Click on the Schedule tab.

2. Select your desired
synchronization schedule.

3. Click OK when done.

To specify synchronization rules:

1. Click on the Rules tab.

2. Select your desired settings from
the available options.

3. Click OK when done.
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Introduction
Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and
Notes. You can use these programs individually or together. For example,
e-mail address stored in Contacts can be used to address e-mail
messages in Inbox.

Using ActiveSync®, you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your desktop computer with your device. You
can also synchronize this information directly with a  Microsoft Exchange
server. Each time you synchronize, ActiveSync compares the changes you
mode on your device and desktop computer or server and updates both
computers with the latest information. For information on using ActiveSync,
see ActiveSync Help on your desktop computer.

You can switch to any of the Pocket Outlook programs by tapping .

Calendar:  Scheduling appointments
and meetings

Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and easily switch views using the
View menu.

NOTE You can customize the Calendar display, such as changing
the first day of the week, by tapping Options on the Tools
menu.

Tap to go to Today

Tap to display or edit the
appointment details

Tap to create a new appointment
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Creating appointments

To create an appointment:

1. If you are in Day or Week view, tap your desired date for the
appointment,

2. Tap New.

3. Using the input panel, enter a description and a location. Tap to select
the field.

4. If needed, tap the date and time to change them.

5. Enter other desired information. You will need to hide the input panel to
see all available fields.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see the “Notes:
Capturing thoughts and ideas” later in this chapter.

7. When done, tap OK to return to Calendar.

NOTE If you select Remind me in an appointment, your device will

remind you according to the options set in , Settings,
Personal tab, Sounds and Notifications.

Tap to select from a predefined text
Tap to select from previously
entered locations
Tap to specify the time of appointment
Tap to specify the date of appointment

Tap to add notes to the appointment
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Using the summary screen
When you tap an appointment in Calendar, a summary screen appears. To
change the appointment, tap Edit.

Creating meeting requests
You can use Calendar to set up meetings with users of Outlook and
Pocket Outlook. The meeting request will be created automatically and
sent either when you synchronize Inbox or when you connect to your
e-mail server.

To create a meeting request:

1. Tap Tools then Options to indicate how you want meeting requests
sent.

2. If you send and receive e-mail messages through ActiveSync, select
ActiveSync.

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, then tap Attendees.

3. From the list of e-mail addresses you have entered in Contacts, select
the meeting attendees.

The meeting notice is created automatically and place in the Outbox
folder. For more information on sending and receiving meeting
requests, see Calendar Help and Inbox Help on the device.

Appointment details

Notes/additional information
on the appointment

Tap to change details of the appointment
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Contacts:  Tracking friends and
colleagues

Contacts maintains a list of your friends and colleagues so that you can
easily find the information you look for, whether you are at home or on the
road. Using the infrared port (IR) on the device, you can quickly share
Contacts information with other device users.

NOTE To change the way information is displayed in the list, tap
Tools then Options.

Tap and enter part of a name
to quickly find it on the list

Tap to select the category of
contacts you want to display

Tap to display additional phone
numbers and email addresses

Tap to display or edit the contact details

Tap to create a new contact

Tap to sort contacts by name or company

Tap an action for a selected contact



4-6 Chapter 4

Creating contacts

To create a contact:

1. Tap  , then tap Contacts.

2. Tap New to display a blank
contact form.

3. Using the input panel, enter a
name and other contact
information. You will need ot scroll
down to see all available fields.

4. To assign the contact a category,
scroll to and tap Categories, then
select a category from the list. On
the contact list, you can display
the contacts by category.

Using the summary screen
Tapping a contact on the contact list displays a summary screen. To
change the contact information, tap Edit.

5. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing thoughts and ideas” later in this chapter.

6. Tap OK to return to the contact list when done.

Contact details

Tap to display notes

Tap to change contact information
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Finding a contact
There are four ways to find a contact.

1. On the contact list, enter a contact
name in the box under the
navigation bar. To show all contacts
again, clear text from the box or tap
the button to the right of the box.

2. In the contact list, tap the category
list (labeled All Contacts by
default) and select the type of
contact that you wish to display. To
show all contacts again, select All
Contacts. To view a contact not
assigned to a category, select
None.

3. To view the names fo companies
your contacts work for, in the
contact list, tap View > By
Company. The number of contacts
that work for that company will be
displayed to the right of the
company name.

4. Tap  , Find, enter the contact
name, select Contacts for the type,
and tap Go.

1

2

3

4
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Tasks:  Keeping a to do list
Use Tasks to keep track of what you have to do.

Creating tasks

To create a task:

1. Tap  , then tap Tasks.

2. Tap New to display a blank task
form.

3. Using the input panel, enter a
description.

4. Enter a start date and due date,
or enter other information by
tapping the field first. If the input
panel is open, you will need to
hide it to see all available fields.

Tap to select a sort
order of the task list

Tap to select the category of
tasks you want to display

Indicates high priority

Tap to display or edit
the task details

Tap and hold to display a
pop-up menu of actions

Tap an action for the task

Tap to create a new task
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5. To assign the task to a category, tap Categories and select a category
from the list. On the task list, you can display tasks by category.

6. To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing thoughts and ideas” later in this chapter.

7. Tap OK to return to the task list when done.

Using the summary screen
Tapping a task on the task list displays a summary screen. To change the
task details, tap Edit.

TIP To quickly create a task with
only a subject, tap Entry Bar on
the Tools menu. Tap Tap here
to add a new task and enter
your task information.

Task details

Tap to show or hide the task details

Notes/additional information on the task

Tap to change the task details



4-10 Chapter 4

Notes:  Capturing thoughts and
ideas

Quickly capture thoughts, reminders, ideas, and phone numbers with
Notes. You can create a written note or a recording. You can also include a
recording in a note. If a note is open when you create the recording, it will
be included in the note as an icon. If the note is displayed, it will be
created as a stand-alone recording.

Tap to change the sort order of the list

Tap to open a note or play a recording

Tap to record

Tap to show or hide the recording toolbar

Tap to create a new note or recording

Tap and hold to display a
pop-up menu of actions

Tap an action for the item

You may change the default Notes options including the writing mode,
template, file storage, and record button action.

To change the Notes options:

1. Tap  , then tap Notes.

2. Tap Tools, then Options... to
display the options screen.

3. Make your desired changes.

4. Click OK.
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Creating notes

To create a note:

1. Tap  , then tap Notes.

2. Tap New to display a blank note.

3. Create your note by writing, drawing, typing, or recording. For more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see Chapter 2.

Tap to show or hide
the input panel

Tap to save the note and
return to the Notes list

Tap to write on the screen

Tap to add a recording to the note
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Inbox:  Sending and receiving e-mail
messages

Use Inbox to send and receive e-mail messages in one of these ways:

• Synchronize e-mail messages with Microsoft Exchange of or Microsoft
Outlook on your desktop computer

• Send and receive e-mail messages by connecting directly to an e-mail
server through an Internet service provider (ISP) or a network

Synchronizing e-mail messages
E-mail messages can be synchronized as part of the general
synchronization process. You will need to enable Inbox synchronization in
ActiveSync. For more information on enabling Inbox synchronization, see
ActiveSync Help on your desktop computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on
your desktop computer to the ActiveSync folder in Inbox on your device.
By default, you will receive messages from the past three days only, the
first 100 lines of each message, and file attachments of less than 100KB
in size.

• E-mail messages in the Outbox folder on your device are transferred to
Exchange or Outlook, then send from those programs.

• E-mail messages in subfolder must be selected in ActiveSync on your
desktop computer in order to be transferred.

NOTE You can also synchronize e-mail messages with your desktop
computer from a remote location. For more information, see
Chapter 7.
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Connecting directly to an e-mail server
In addition to synchronizing e-mail messages with your desktop computer,
you can send and receive e-mail messages by connecting to an e-mail
server using a modem or network card connected to your device. You
need to set up a remote connection to a network or an ISP, and a
connection to your e-mail server. For more information, see Chapter 7.

When you connect to the e-mail server, new messages are downloaded to
the device Inbox folder, messages in the device Outbox folders are sent,
and messages that have been deleted on the e-mail server are removed
from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your
e-mail server rather than your desktop computer. When you delete a
message on your device, it is also deleted from the e-mail server the next
time you connect based on the settings you selected in ActiveSync.

You can work online or offline. When working online, you read and
respond to messages while connected to the e-mail server. Messages are
sent as soon as you tap Send, which saves space in your device.

When working offline, once you have downloaded new message headers
or partial messages, you can disconnect from the e-mail server and decide
which messages to download completely. The next time you connect,
Inbox downloads the complete messages you have marked for retrieval
and sends the messages you have composed.



4-14 Chapter 4

Using the message list
The messages you receive are displayed in the message list. By default,
the most recently received messages are displayed first in the list.

When you receive a message, tap it to open. Unread messages are
displayed boldface.

Tap to select the sort order
for the messages

Tap and hold to display a
pop-up menu of actions

Tap to connect, and to send/receive e-mail

Tap to connect to the selected service

Tap to select the service, and the
folder that you wish to display

Tap to return to the message list

Tap to delete this message

Tap to reply to or forward this message

Tap to view the next message

Tap to view the previous message
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When you connect to your e-mail server or synchronize with your desktop
computer, by default, you will receive messages from the last five days
only, the first 100 lines of each new messages, and file attachments of less
than 100KB in size. The original messages remain on the e-mail server or
your desktop computer.

You can mark the messages that you want to retrieve in full during your
next synchronization or e-mail server connection. In the message list, tap
and hold the message that you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list give you visual
indications of message status.

You can specify your downloading preferences when you set up the
service or select your synchronization options. You can change them at
any time.

• Change options for Inbox synchronization using ActiveSync options. For
more information, see ActiveSync Help on your desktop computer.

• Change options for direct e-mail server connections in Inbox on your
device. Tap Tools then Options. On the Service tab, tap the service that
you wish to change. Tap and hold the service and select Delete to
remove a service.
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Composing messages

To compose a message:

1. Tap New.

2. In the To field, enter an e-mail or SMS address of one or more
recipients, separating them with a semicolon, or select a name from
the Contacts list by tapping the Address Book button. All e-mail
addresses entered in the e-mail fields in Contacts appear in the
Address Book.

3. Compose your message. To enter
preset or frequently used
messages, tap My Text and
select a message.

4. Tap Send when you have finished
the message. If you are working
offline, the message is moved to
the Outbox folder and will be sent
the next time you connect.

Tap to show or hide the
complete message header

Tap to send the message

Tap to select a preset message
Tap to display the e-mail address book

Tap to show or hide the recording toolbar
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Managing e-mail messages and folders
The behavior of the folders you create depends on whether you are using
ActiveSync, SMS, POP3, or IMAP4.

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will
automatically be sunchronized with your device. You can select to
synchronize additional folders by designating them for ActiveSync. The
folders you create and the messages you move will then be mirrored on
the server. For example, if you move two messages from the Inbox folder
to a folder named Family, and you have designated Family for
synchronization, the server creates a copy of the Family folder and
copies the messages into that folder. You can then read messages while
away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder.

• If you use POP3 and you move e-mail messages to a folder you created,
the link is broken between the messages on the device and their copies
on the mail server. The next time you connect, the mail server will see
that the messages are missing from the device Inbox and delete them
from the server. This prevents you from having duplicate copies of a
message, but it also means that you will no longer have access to
messages that you move to folders created from anywhere except the
device.

• If you use IMAP4, the folders you create and the e-mail messages you
move are mirrored on the server. Therefore, messages are available to
you anytime you connect to your mail server, whether it is from your
device or desktop computer. This synchronization of folders occurs
whenever you connect to your mail server, create new folders, or
rename/delete folders when connected.
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The companion programs consist of Microsoft® Pocket Word, Microsoft®

Pocket Excel, MSN Messenger, Windows Media™ Player for Pocket PC,
and Microsoft® Reader.

To switch to a companion program on your device, tap Programs on the
 menu, then tap the program that you wish to open.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give
you easy access to copies of your documents. You can create new
documents on your device, or you can copy documents from your desktop
computer to your device. Synchronize documents between your desktop
computer and your device so that you have the most up-to-date content in
both locations.

Use Pocket Word to create documents, such as letters, meeting minutes,
or trip reports.

1. Tap  , tap Programs, tap
Pocket Word to launch the
application.

If you have existing Microsoft
Word or Pocket Word documents
in your device, a list of the
documents appears.

Creating Pocket Word documents

To create a new Word document:

NOTE If you selected a template for new documents in the Options
dialog box, that template appears with the appropriate text
and formatting already provided.
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2. Tap New to display a blank document.

3. Use any of the tools in the input panel to type your text.

Type your text here

Tap to select an input method

Tap to show or hide the input panel

Tap to show or hide the formatting toolbar

Tap to save and close your document

Formatting toolbar

Saving Pocket Word documents

To save a Pocket Word document:

When you have finished editing your document, tap OK.

The document is saved using the first line as file name if you did not
specify a file name. For example, if your first line in the document has
the words Bits-n-Pieces, these words appear in your Word documents
list.
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To specify save options:

1. With the document open, tap
Tools.

2. From the pop-up menu, tap Save
Document As... to display the
Save As screen.

3. Change the file name by simply
typing a new one in the Name
field.

4. Tap the down arrow in the Folder
field to select a folder where you
wish to place the file.

NOTE If you do not wish to change the document format, but would
like to change the file name, folder, and location of your
document, simply tap Edit from the command bar, then tap
Rename/Move... from the pop-up menu to make your
changes.

5. Tap the down arrow in the Type field to select a file format.

You can save the document you create or edit in a variety of formats:

• Word (.doc)

• Pocket Word (.psw)

• Rich Text Format (.rtf)

• Plain Text (.txt)

6. Tap the down arrow in the Location field to indicate the location of
your saved file, either in the main memory of your device, or in a
storage card, if available.

7. Tap OK when done.
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Opening an existing Pocket Word document
Pocket Word contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

NOTE You can open only one Pocket Word document at a time;
when you open a second document, you will be asked to
save the first.

Tap to select the folder you want to display

Tap to change the sort order of the list

Tap to open a document

Tap to create a new document

Tap to change document settings
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Modes of entering information
You can enter information in Pocket Word in one of four modes (typing,
writing, drawing, or recording), which are displayed on the View menu.
Each mode has its own toolbar that you can show or hide by tapping the
Show/Hide Toolbar button on the command bar.

If you are opening a Word document created on a desktop computer,
select Wrap to Window on the View menu so that you can see the entire
document.

To change the zoom magnification:

1. Tap View, then tap Zoom.

2. Select your desired percentage.

Select a higher percentage to enter text and lower one to see more of
your document.

Typing Mode

Using the input panel, enter typed text into the document. For more
information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the mouse
to drag through the text you want to select. You can search a document to
find text by tapping Edit and Find/Replace.
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Writing mode

In writing mode, use your stylus to write directly on the screen. Ruled lines
are displayed as a guide, and the zoom magnification is greater than in
typing mode to allow you to write more easily. For more information on
writing and selecting writing, see Chapter 2.

NOTE If you cross three ruled lines in a single stylus stroke, the
writing becomes a drawing, and can be edited and
manipulated as described in the next section.

Written words are converted to graphics (metafiles) when a
Pocket Word document is converted to a Word document on
your desktop computer.

Write your text here

With the Space button selected,
drag to insert space. An arrow
appears showing the space
direction direction and size.

Tap to show or hide the writing/formatting toolbarPen button

Space button

Tap to display the menu

Tap to display zoom percentages

Tap to wrap text to screen
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Drawing mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear
as a guide. When you lift your stylus off the screen after ther first stroke,
you will see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see
Chapter 2.

Recording mode

In recording mode, embed a
recording into your document.
Recordings are saved as .wav files.
For more information on recording,
see Chapter 2.

Resize an object by dragging
the selection handles

Tap an arrow to display the options
Pen button

Drawing toolbar

Tap to show or hide the drawing toolbar

Tap to select the formatting options

Embedded recording
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Pocket Excel
Pocket Excel works with Microsoft Excel on your desktop computer to give
you easy access to copies of your workbooks. You can create new
workbooks on your device, or you can copy workbooks from your desktop
computer to your device. Synchronize workbooks between your desktop
computer and your device so that you have the most up-to-date contents
in both locations.

Use Pocket Excel to create workbooks, such as expense reports and
mileage logs.

Pocket Excel contains a list of the files stored on your device. Tap a file in
the list to open. To delete, make copies of, and send files, tap and hold a
file in the list, then select the appropriate action on the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View, then tap
Toolbar.

NOTE You can open only one Pocket Excel document at a time;
when you open a second document, you will be asked to
save the first.

Cell contents appear here as you
type, or when you select the cell

Zoom button

Format button

AutoSum button
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Saving Pocket Excel documents

To save an Excel document:

When you have finished editing your document, tap OK.

By default, your document is saved as Book1 as file name. You can
change the file name to one that is more descriptive of your document.
See next section for saving options.

1. Tap  , tap Programs, tap
Pocket Excel.

2. Tap New to display a blank
document.

If you selected a template for new
documents in the Options dialog
box, that template appears with
the appropriate text and
formatting already provided.

Creating Pocket Excel documents

To create a new Excel document:
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To specify save options:

1. With the document open, tap
Tools.

2. From the pop-up menu, tap Save
Workbook As... to display the
Save As screen.

3. Change the file name by simply
typing a new one in the Name
field.

4. Tap the down arrow in the Folder
field to select a folder where you
wish to place the file.

NOTE If you do not wish to save your workbook to a different format,
but would like to change the file name, folder, and location of
your document, simply tap Edit from the command bar, then
tap Rename/Move... from the pop-up menu to make your
changes.

5. Tap the down arrow in the Type field to select a file format.

You can save the document you create or edit in a variety of formats:

• Pocket Excel (.pxl)

• Excel (.xls)

6. Tap the down arrow in the Location field to indicate the location of
your saved file, either in the main memory of your device, or in a
storage card, if available.

7. Tap OK when done.
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Securing your Excel document
If your workbook contains sensitive or confidental information, you can
protect it with a password.

To set a password for your workbook:

1. Open the workbook.

2. Tap Edit from the command bar,
then tap Password... to display
the password setting screen.

3. Type a password in the
Password field.

4. Re-type the password in the
Verify Password field.

5. Tap OK when done.

If you have set a password for your
workbook, a password screen
appears asking you to type your
password whenever you try to open
the workbook.

Type your password, then tap OK. If
you type in a wrong password, a
message appears telling you so.

NOTE DO NOT forget your password! You can not open your
workbook unless you type in the correct password.
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Tips for working in Pocket Excel
Take note of the following when working in large worksheets in Pocket
Excel:

• View in full-screen mode to see as much of your worksheet as
possible. Tap View, then tap Full Screen. To exit full-screen mode, tap
Restore.

• Show and hide window elements. Tap View, then tap the elements to
show or hide.

• Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View, then tap Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep row and
column labels visible as you scroll through a sheet.

• Split panes to view different areas of a large worksheet. Tap View, then
tap Split. Drag the split bar to where you want it. To remove the split, tap
View, then tap Remove Split.

• Show and hide rows and columns. To hide a row or column, select a
cell in the row or column that you want to hide. Tap Format, then tap
Row or Column, and tap Hide. To show a hidden row or column, tap
Tools, then tap Go To, and type a reference that is in the hidden row or
column. Tap Format, then tap Row or Column, and tap Unhide.

For more information on using Pocket Excel, tap  , then tap Help.
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MSN Messenger
MSN Messenger on your device is an instant messaging program that
allows you to:

• See who is online

• Send and receive instant messages

• Have instant message conversations with groups of contacts

To use MSN Messenger:

You must have a Microsoft Passport™ account or a Microsoft
Exchange e-mail account.

You must have a Passport to use the MSN Messenger Service. If you
have a Hotmail® or MSN account, you already have a passport. Once you
have obtained either a Microsoft Passport or Microsoft Exchange account,
you are ready to set up your account.

Sign up for a Microsoft Passport account at http://www.passport.com.

Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com.

To launch MSN Messenger:

1. Tap  , then tap Programs.

2. Tap MSN Messenger.
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Signing up

To sign in to MSN Mesenger service:

NOTE If you already use MSN Messenger on your desktop
computer, your contacts will show up on your device without
being added again.

1. Tap Tools then tap Sign in... from
the menu.

OR

Simply tap the Tap here to sign
in area.

2. In the sign-in screen, enter your
e-mail address and password.
Tap Sign In.
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Working with contacts
The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send an e-mail, block the contact from
chatting with you, or delete contacts from your list using the pop-up menu.

To see others online without being seen, tap My Status in the Tools menu
and select Appear Offline.

If you block a contact, you will appear offline but will remain on the blocked
contact’s list. To unblock a contact, tap and hold the contact, then tap
Unblock on the pop-up menu.
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Chatting with contacts
Tap a contact name to open a chat window. Enter your message in the text
entry area at the bottom of the screen, or tap My Text to enter a preset
message, then tap Send. To invite another contact to a multi-user chat, tap
Invite in the Tools menu, then tap the contact that you want to invite.

NOTE To switch back to the main window without closing a chat, tap
the Contacts button. To go back to your chat window, tap
Chats and select the person whom you were chatting with.

To know if the contact you are chatting with is responding, look for the
message under the text entry area. For more information on using MSN
Messenger, tap  , then tap Help.
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Windows Media Player for Pocket PC
Use Microsoft® Windows Media Player for Pocket PC to play digital audio
and video files that are stored on your device or on a network. To switch to

Windows Media Player for Pocket PC, tap  , tap Programs, then tap
Windows Media.

Use Microsoft Windows Media Player on your desktop computer to copy
digital audio and video to your Pocket PC. You can play Windows Media
and MP3 files on your Pocket PC.

For more information on using Windows Media Player for Pocket PC, tap
 , then tap Help.

Indicates the progress
of the current track

Tap to play or pause

Tap to stop
Tap to play the previous track

Tap to play the next track

Slide to adjust volume

Tap to mute sound
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Microsoft Reader
Use Microsoft Reader to read eBooks on your device. Download books to
your desktop computer from your favorite eBook web site. Then, use
ActiveSync to copy the book files to your activated device. The books
appear in the Reader Library.

Each book consists of a cover page, an optional table of contents, and the
pages of the book. You can:

• Page through the book using the Up/Down control on your device, or by
tapping the page number on each page.

• Annotate the book with highlighting, bookmarks, notes, and drawings.

• Search for text and look up definitions for words.

The Guidebook contains all the information that you need to use the
software. To open  the Guidebook, tap Help on the Reader command bar.
Or, on a book page, tap and hold on the book title, then tap Help on the
pop-up menu.

To launch Microsoft Reader:

1. Tap  , then tap Programs.

2. Tap Microsoft Reader.
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Using the Library
The Library is your Reader home page. It displays a list of all books stored
on your device or storage card.

To open the library:

1. On the Reader command bar, tap Library.

2. On a book page, tap the book title, then tap Library on the pop-up
menu.

To open a book, tap its title on the Library list.

Tap to scroll through
the Library list

Tap to select
a sort order

Tap to search books
by author or title

Tap to navigate to
other parts of the
Reader

A list of books you
have stored appears
here

Getting books on your device
You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.

Sample books and a dictionary ar also included in the MSReader folder in
the Extras folder on the Pocker PC Companion CD.

Use ActiveSync to download the files from your desktop computer to your
activated device as described in the Read Me file in the MSReader folder.
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Reading a book
Each book consists of a cover page, and optional table of contents, and
the pages of the book. Navigation options are listed in the bottom portion
of the cover page.

The first time you open a book, you will probably want to go to the first
page or to the table of contents, if there is one. Subsequently, whenever
you open a book, you will be automatically taken to the last page read.

In addition to the text, each book page includes a page number and the
book title.

You can also page through a book using the Up/Down control on your
device.
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Using Reader features
Reading a book electronically gives you several options not available with
paper books. These options are available from any book page.

Select text by dragging across the text on the page. Then, tap an option on
the pop-up menu, as described below.

• Search for Text. Find text in a book by tapping Find on the pop-up
menu. Enter the word you want to search for, and tap the desired Find
option. Reader highlights found text on the page. To close Find, tap
outside the box. To return to your original page, tap the title then tap
Return on the pop-up menu.

• Copy Text. You can copy text form books that support this feature into
any program that accepts text. On a book page, select the text that you
want to copy. Then, tap Copy Text on the pop-up menu. The text can be
pasted into the program of your choice.

• Bookmarks. When you add a bookmark to a book, a color-coded
bookmark icon appears on the right margin. You can add multiple
bookmarks to a book. Then, from anywhere in the book, tap the
bookmark icon to go to the bookmarked page.

• Highlights. When you highlight text, it appears with a colored
background.

• Notes. When you attach a note to text, you enter the text in a note pad
that appears on top of the book page. A Note icon appears on the left
margin. To show or hide the note, tap the icon.

• Drawings. When you add a drawing, a Drawing icon appears on the
bottom-left corner of the page, and drawing tools appear across the
bottom of the page. Draw by dragging your stylus.

NOTE To see a list of a book’s annotations, including bookmarks,
highlights, text notes, and drawings, tap Annotations Index
on the book’s cover page. You can tap an entry in the list to
go to the annotated page.

Removing a book
When you finish reading a book, you can delete it to conserve space on
your device. If a copy of the book  is stored on your desktop computer, you
can download it again at any time.

To remove a book from your device, tap and hold the title in the Library list,
then tap Delete on the pop-up menu.
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Introduction
Use Microsoft Pocket Internet Explorer to view Web or WAP pages in any
of these ways.

• During synchronization with your desktop computer, download your
favorite links and mobile favorites that are stored in the Mobile Favorites
sub-folder in the Internet Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the
Web. To do this, you need to create the connection first. See Chapter 7
for information on creating a connection.

When connected to an ISP or network, you can also download files and
programs from the Internet or intranet.

Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and
channels that have been downloaded to your device without connecting to
the Internet. You can also connect to the Internet through an ISP or a
network connection to browse the Web.

To launch Pocket Internet Explorer:

1. Tap  , then Internet Explorer
to display the Pocket MSN
services.

Tap to launch Favorites
Tap to go to Pocket Internet Explorer home

Tap to stop/refresh

Tap to go back to previous page

New Pocket MSN services



Pocket Internet Explorer 6-3

2. Tap the Home button to display
the Pocket Internet Explorer
welcome screen with links to
some useful Web sites.

3. Tap any of the Web site buttons to
go to a specific site.

Changing View settings

To change View settings:

1. Tap View to display a pop-up
menu.

2. Tap Fit to Screen to see all the
screen items at the same time.

3. Tap Address Bar to display the
Web site address bar.

4. Tap and hold Text Size to display
another pop-up menu with a text
size selection. Select your desired
text size for the screen.

Browsing the Internet

To browse the Internet:

1. Set up a connection to your ISP or corporate network using
Connections. See Chapter 7 for details.

2. Do one of the following to connect and start browsing:

• Tap the Favorites button, then tap the favorite that you wish to view.

• Tap View, then Address Bar. Enter the Web address that you want
to visit then tap Go.
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AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized
content and thousands of popular Web sites. You subscribe to AvantGo
channels directly from your device. Then, synchronize your device and
desktop computer, or connect to the Internet to download the content.

For more information, visit the AvantGo web site at http://avantgo.com/

To activate AvantGo:

1. In the ActiveSync window on your
desktop computer, click Options.

2. In the Sync Options tab, check
the box beside the AvantGo item.
Click OK.

ActiveSync automatically updates
the settings and synchronizes
with your device.

NOTE Make sure that your computer is connected to the Internet.

3. When synchronization is
complete, the AvantGo home
page appears on your device.

To launch AvantGo:

1. In Pocket Internet Explorer on
your device, tap the Favorites
button to display your list of
favorites.

2. Tap the AvantGo Channels link
to go directly to the AvantGo
home page and see a few of the
most popular channels.

To add or remove channels:

Tap the Add or Remove link.
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Mobile Favorites folder
Only items items stored in the Mobile Favorites sub-folder in the Favorites
folder in the Internet Explorer on your desktop computer will be
synchronized with your device. This folder was created automatically when
you installed ActiveSync.

Favorite links
During synchronization, the list of favorite links in the Mobile Favorites
folder on your desktop computer is synchronized with Pocket Internet
Explorer on your device. Both computers are updated with changes made
to either list each time you synchronize. Unless you mark the favorite link
as a mobile favorite, only the link will be downloaded to your device, and
you will need to connect to your ISP or network to view the content. For
more information on synchronization, see ActiveSync Help on the desktop
computer.

Mobile Favorites
If you are using Microsoft Internet Explorer 5.0 or later on your desktop
computer, you can download mobile favorites to your device.
Synchronizing mobile favorites downloads Web content to your device so
that you can view pages while you are disconnected from your ISP and
desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile
favorites quickly.
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To create a mobile favorite:

1. In Internet Explorer on your desktop
computer, click Tools then Create
Mobile Favorite.

2. To change the link name, enter a new
name in the Name box.

3. Select your desired update schedule
in Update. This is optional.

4. Click OK. Internet Explorer downloads
the latest version of the page to your
desktop computer.

5. If you want to download the pages that
are linked to the mobile favorite you
just created, in Internet Explorer on the
desktop computer, right-click the
mobile favorite, then click Properties.
In the Download tab, specify the
number of links deep you want to
download. To conserve device
memory, go only one level deep.

6. Synchronize your device and your
desktop computer. Mobile favorites that
are stored in the Mobile Favorites in
Internet Explorer are downloaded to
your device.

NOTE If you did not specify an update schedule in step 3, you will
need to manually download content to keep the information
updated on your desktop computer and device. Before
synchronizing with your device, in Internet Explorer on your
desktop computer, click Tools then Synchronize. You will
see the last time content was downloaded to the desktop
computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for
creating mobile favorites. In Internet Explorer on your desktop
computer, click View, Toolbars, and Customize.
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Viewing mobile favorites and channels

To view mobile favorites and channels:

1. Tap  to display your list of favorites.

2. Tap a Favorites page that you wish to view.

You will see the page that was downloaded the last time you
synchronized with your desktop computer. If the page is not on your
device, the favorite is dimmed. You need to synchronize with your
desktop computer again to download the page to your device, or
connect to the Internet to view the page.

Tap the favorite that
you wish to view

Tap to add or delete a
folder or favorite link

Saving device memory

Mobile favorites take up storage memory on your device. To minimize the
amount of memory used:

• In the settings for the Favorites information type in ActiveSync options,
turn off pictures and sounds, or stop some mobile favorites from being
downloaded to the device. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Interner Explorer on
your desktop computer, right-click the mobile favorite you want to
change, then click Properties. In the Download tab, specify 0 or 1 for
the number of linked pages you want to download.
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Adding/Deleting mobile favorites and folders

To add a favorite:

1. Tap  to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Tap the Add... button to show the
Add Favorite screen.

4. Type a name for the favorite that
you wish to add in the Name field.

5. Type in the URL address in the
Address (URL) field.

6. Select a folder to place the
favorite from the Create in: box.

7. Tap Add to return to the Favorites
screen, which now shows the
favorite that you added.

To delete a favorite:

1. Tap  to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Select the favorite that you wish
to delete, then tap Delete.

4. When prompted to permanently
delete the favorite, tap Yes.
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To add a folder:

1. Tap  to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Tap the New Folder button.

4. Type a name for the folder that
you wish to create.

5. Tap Add to return to the Favorites
screen, which now shows the
folder that you added.

To delete a folder:

1. Tap  to display your list of
favorites.

2. Tap the Add/Delete button to
display the Favorites screen.

3. Select the folder that you wish to
delete, then tap Delete.

4. When prompted to permanently
delete the folder, tap Yes.
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Introduction
You can set up connections to the Internet and corporate network at work
in order to do such activities as browse the Internet or intranet, send and
receive e-mail and instant messages, and synchronize information using
ActiveSync.

Connections can be made using a modem, wireless network, or
network (Ethernet) card. A modem connection can be used to set up
connections with an external modem, or through your mobile phone
network using a cellular line.

Your device has two groups of connection settings: My ISP and My Work
Network. My ISP settings are used to connect to the Internet, and My
Work Network settings can be used to connect to any private network,
such as a corporate network you use at work. Simply fill in the settings and
get ready to start connecting. For more information, see the sections
“Connect to the Internet” or “Connect to Work.”

You may also establish connection to another device with infrared (IR) or
Bluetooth features. For more information, see sections “Infrared (IR)
connection” or “Bluetooth connection.”

Connect to the Internet

To connect to the Internet:

1. Obtain the following information from your ISP:  ISP server phone
number, user name, and password.

2. Tap   > Settings > Connections tab > Connections.

3. In My ISP, tap Add a new modem connection.

4. Create a modem connection. For more information, see section “Set
up modem connections.”

5. To start the connection, begin using the desired program. For example,
switch to Pocket Internet Explorer and browse a Web page. Your
device automatically connects.

NOTE To set up a network card or wireless network connection to
your ISP, add a new connection under My Work Network.
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Connect to Work
1. Obtain the following information from your network administrator:

server phone number, user name, and password.

2. Tap   > Settings > Connections tab > Connections.

3. In My Work Network, set up either a modem, network card, wireless
network, or VPN server connection. Refer to the section “Set up
connections” for the procedure.

4. To start the connection, start using a desired program. For example,
switch to Pocket Internet Explorer and browse to a Web page. Your
device automatically starts connecting.

Set up connections

Modem connections

To set up a modem connection:

Obtain the following information from your ISP or network administrator:
telephone number, user name, password, domain name, and TCP/IP
settings.

If your device does not have access to a mobile phone network, insert a
modem card.

1. Tap   > Settings > Connections tab > Connections.

2. To create a new connection, in either My ISP or My Work Network,
tap Add a new modem connection, then follow the instructions in the
New Connection wizard.

3. To view additional information for any screen in the wizard or while

changing settings, tap .

NOTE To change modem connection settings in either My ISP or My
Work Network, tap Manage existing connections. Select
the desired modem connection, tap Settings, and follow the
instructions on the screen.
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VPN server connections
A VPN connection helps you to securely connect to servers, such as a
corporate network, via the Internet. Ask your network administrator for your
user name, password, domain name, TCP/IP settings, and host name or
IP address of the VPN server.

To set up a VPN server connection:

1. Tap   > Settings > Connections tab > Connections.

2. To create a new VPN server connection, in My Work Network, tap Add
a new VPN server connection, then follow the screen instructions.

3. To view additional information for any screen in the wizard or while

changing settings, tap .

NOTE To change existing settings, in My Work Network, tap
Manage existing connections > VPN tab. Select your
desired VPN connection, tap Settings, then follow the
instructions on the screen.

Proxy server settings
If you are connected to your ISP or private network during synchronization,
your mobile device should download the proper proxy settings from your
PC. If these settings are not on your PC or need to be changed, ask your
ISP or network administrator for the proxy server name, server type, port,
type of Socks protocol used, and your user name and password.

To change proxy server settings:

1. Tap   > Settings > Connections tab.

2. To create a new connection, in My Work Network, tap Add a new
proxy server.

3. To change proxy server settings, in My Work Network, tap Edit my
proxy server. Select the desired proxy server, and tap Settings.

4. Select This network connects to the Internet and This network uses a
proxy server to connect to the Internet.

5. In the Proxy server box, enter the proxy server name.

6. To change such settings as port number or proxy server type, tap
Advanced and change desired settings.
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Network card connections
Use a network (Ethernet) card to connect directly to a network. Once
connected, you can view the Internet or intranet, or download e-mail. You
do not need to create a new connection on your device. For more
information, see your network administrator. Make sure to purchase and
configure a network card that is compatible with your device.

To set up a network card:

1. Obtain the following information from your network administrator: user
name, password, and domain name.

2. Insert the network card into your device.

3. The first time you insert the card, Network Settings appears
automatically so that you can configure the network card. If it does not
appear, or to change settings later, tap   > Settings > Connections
tab > Connections > Advanced tab > Network Card.

4. If you need to enter specific server information, tap the appropriate
adapter, and then tap Properties. Most networks use DHCP, so you
should not have to change these settings unless your network
administrator instructs you to do so.

5. If necessary, connect the network card to the network by using a
network cable. For information, refer to the documentation that came
with your network card.

6. To start a connection, insert the network card, and begin using a
desired program. For example, switch to Pocket Internet Explorer
and browse a Web page. Your device automatically starts connecting.

If you use your network card with two networks, such as a private
network at work and one at home for the Internet, you need to change
the network to which the network card connects.

NOTE You may need proxy server and VPN connection settings.
For more information, see your network administrator.



7-6 Chapter 7

Wireless network connections
Networks that you have already configured are preferred networks and are
listed in Wireless networks. You can select to connect to only preferred
networks or have your device search for and connect to any available
network whether it is preferred or not.

To set up a wireless network:

1. Tap   > Settings > Connections tab > Connections > Network
Card > Wireless tab.

2. To change network settings, in Wireless networks, tap a network. If
you do not see a desired network, tap Add new and follow the
instructions on the screen.

3. From Networks to access, select All available, Only access points,
or Only computer-to-computer depending on the type of network(s)
you connect to.

4. To connect only to networks you have already configured, clear
Automatically connect to non-preferred networks.

NOTE If you select to automatically connect to non-preferred
networks, your device detects any new networks and provide
you the opportunity to configure them.

Enter settings information
A wireless network can be added either when the network is detected, or
manually by entering settings information.

To enter new settings:

1. To manually enter information, tap   > Settings > Connections tab
> Connections > Network Card > Wireless tab. Then, tap Add new.
If the network was detected, step one is not necessary.

2. In the General tab, enter a network name. If the network was detected,
the network name is automatically entered and can't be changed.

3. From Connects to, select what your network connects to, Work or the
Internet.

4. To connect to an ad-hoc connection, select This is a device-to-
computer (ad-hoc) connection.
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Configure authentication settings
A wireless network can be added either when the network is detected, or
manually by entering settings information. To determine if authentication
information is needed, see your network administrator.

To configure authentication settings:

1. To manually enter information, tap   > Settings > Connections tab
> Connections > Network Card > Wireless tab.

2. Tap Add new. If the network was detected, step one and two are not
necessary.

3. To use data encryption, tap Data encryption (WEP enabled).

4. To use Shared Key authentication, tap Network Authentication
(shared mode). You need a network key.

5. To automatically use a network key, tap The key is provided for me
automatically. Otherwise, enter the network key.

6. For increased security, select Use IEEE 802.1x network access
control, then select the appropriate EAP type.

Change connection settings name
Your mobile device is already set up with two sets of connection settings:
My ISP and My Work Network. You can change the name of these
settings to something more familiar. For example, if you put all of your
corporate settings under My Work Network, you can change the name
from My Work Network to your company name.

To change a connection name:

1. Tap   > Settings > Connections tab > Connections.

2. Under My ISP or My Work Network, tap Manage existing
connections.

3. Tap the General tab.

4. Enter a name for the settings.
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End a connection
• When connected via modem or VPN, tap   on the navigation bar,

then tap Disconnect.

• When connected via cable or cradle, detach your device from the cable
or cradle.

• When connected via Infrared, move the device away from the other
computer or device.

• When connected via a network (Ethernet) card, remove the card from
your device.

• When connected via a wireless network, switch off the connection.

Set up a WAP gateway
To access WAP sites through Pocket Internet Explorer, configure your
device to use a WAP gateway. Use the following steps to create a new set
of connections to the Internet with WAP gateway settings.

NOTE Some device models do not support the WAP sites viewing
feature.

1. Get the following information from your ISP: ISP server phone number,
user name, and password. Also, contact your mobile phone service
provider and ask for your WAP gateway server name and port number.

2. Tap   > Settings > Connections tab > Connections > Tasks tab.

3. Tap Edit my proxy server. If a proxy server has not been set up, tap Set
up my proxy server.

4. In Programs that automatically connect to the Internet should
connect using, tap New and enter a name for the ISP connection.

5. On the Proxy Settings tab, select This network connects to the
Internet and This network uses a proxy server to connect to the
Internet.

6. If necessary, in the Proxy server box, enter the proxy server name.

7. Tap Advanced.

8. In the WAP box, enter the WAP gateway server name. Under Port,
enter the port number. The most common WAP port number is 9201.
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Use dialing rules
Additional numbers may need to be dialed depending on your given
location when connecting. For example, if you want to dial from work, a 9
prefix must often be dialed, or an area code is needed.

To avoid creating a new modem connection for each situation, set dialing
rules for the locations from which you connect often. Three dialing
locations, Home, Mobile, and Work, have been created for you, and you
can create more. If a connection cannot be made, your device gives you
an opportunity to change the dialing location.

1. Tap   > Settings > Connections tab > Connections > Advanced
tab.

2. Tap Select Location.

3. Tap Use dialing rules.

4. Select a location.

• Home - Dials the number as a local call without a 9 prefix.

• Work - Dials the number as local call with the 9 prefix.

NOTE To create a new location, tap New and follow the directions
on the screen. To view additional information at any time,

tap .

9. Create a modem connection. See section “Set up connections.”

If necessary, set dialing rules. See section “Use dialing rules.”

10. If your device does not have a connection to a mobile phone network,
insert a modem card.
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Infrared (IR) connection
By default, your device detects incoming infrared (IR) beams and prompts
you to accept them. If you do not want your device to detect or receive
beans, clear the Receive all incoming beams check box.

To set the Beam options:

1. Tap  , then Settings.

2. Tap the Connections tab.

3. Tap the Beam icon to display the
Settings screen.

4. Make your desired change and tap OK.

5. To receive an infrared beam from this screen, tap the link at the
bottom. Your device automtically looks for another device using
infrared.
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Receiving information

To receive information:

1. Align the IR ports so that they are unobstructed and within a close
range.

2. Have the owner of the other device send the information to you. Your
device automatically receive the information.

NOTE You can also send items, but not folders, from File Explorer.
Tap and hold the item that you want to send, then tap Beam
File on the pop-up menu.

Sending information

To send information:

1. Switch to the program where you
created the item that you want to
send, and locate that item in the
list.

2. Align the IR ports so that they are
unobstructed and within a close
range.

3. Tap and hold the item, then tap
Beam File... on the pop-up menu.
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Introducing Bluetooth®

Bluetooth is a short-range wireless communications technology. Devices
with Bluetooth capabilities can exchange information over a distance of
about 10 meters (30 feet) without requiring a physical connection.

Unlike infrared, you don’t need to line up the devices to beam information
with Bluetooth. The devices only need to be within a range of about 10
meters. You can even beam information to a device in a different room, as
long as it is within the specififed range.

Bluetooth® for Windows® CE (BTW-CE)
BTW-CE is the solution to smoothly integrate the Bluetooth technology into
devices that use the Pocket PC operating system.

The Bluetooth technology allows your Pocket PC to:

• Locate other Bluetooth devices within the vicinity

• Discover the services that those devices offer

• Connect to, use, and disconnect from those services

• Enable or disable individual services

• Use security features including authentication, authorization, and
encryption

Bluetooth icon
The Bluetooth icon is located on the lower
right corner of the Today screen.

When Bluetooth is enabled (turned ON),

the icon is blue  , and the Bluetooth LED
on the left side of the device blinks blue.

When Bluetooth is disabled (turned OFF),
the icon is grayed with a red X on its lower
right corner .

Tapping the icon displays a menu that
allows you to:

• turn Bluetooth on or off

• launch the Bluetooth Manager

• change the Bluetooth Settings

Bluetooth icon
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Bluetooth settings

To configure the Bluetooth settings:

1. Tap  from the lower right corner of
the Today screen to display the
Bluetooth menu.

2. Tap Bluetooth Settings.

3. Tap one of the tabs at the bottom of
the Settings screen to make your
desired changes.

General
Allows you to:

• select the user profile

• see the Bluetooth status (ON/OFF)

• turn Bluetooth ON or OFF

• tap a link to the Bluetooth Manager

Accessibility
Allows you to:

• set the device name

• see the Bluetooth Device Address
(BDA)

• select the remote devices you wish to
connect

• set whether to allow remote devices to
see your device
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File Transfer
Allows you to customize the settings for
file transfers, and set the highest level
directory on your device that remote
devices can access.

Refer to section “Remote device
services” for more information.

Information Exchange
Allows you to customize the service
settings, and set the default business
card.

Serial Port
Allows you to customize the service
settings, and display the serial port
addresses. The port address
assignments cannot be changed.

Refer to section “Remote device
services” for more information.
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Personal Network Server
Allows you to customize the service
settings for your personal network
server.

Refer to section “Remote device
services” for more information.

Audio Gateway
Allows you to customize the service
settings for the Audio Gateway.

About
Displays the Bluetooth™ for Windows®

CE (BTW-CE) information including the
release version, copyright notice,
website address, technical support
email, and the Advanced button. The
Advanced buttons contains the version
information about the individual software
modules that make up BTW-CE.

The information on this screen is not
configurable.
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Bluetooth Manager
The Bluetooth Manager allows you to create, manage, and use Bluetooth
to connect to remote devices.

To launch the Bluetooth Manager:

Tap  , then tap the Bluetooth Manager
from the Start menu.

The My Shortcuts screen displays a list of pre-configured connections, if
any. Tap New > Connect to connect to other devices via Bluetooth.

The Active Connections screen displays the active incoming and outgoing
connections.

Tap to make a new connection
Tap to add or remove paired devices

Tap to set view options
Tap to launch the Bluetooth connection wizard

Tap to set Business Card exchange options
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Bluetooth connection wizard
The Bluetooth connection wizard helps you set up connections with
remote Bluetooth devices.

To launch the Bluetooth connection wizard:

1. Tap   from the Bluetooth Manager
command bar. The Bluetooth
Connection Wizard screen appears.

2. Select a type of connection that you
wish set up. Tap Next.

Tap Cancel if you do not wish to
continue the connection process.

NOTE Refer to the device online help for other information on
Bluetooth.
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Business Card Exchange
The Business Card Exchange function allows you to:

• send your business card to a remote device

• receive a business card from a remote device

• exchange business cards with one or more remote devices

To launch the Business Card Exchange screen:

1. Tap    from the  Bluetooth Manager
command bar.

2. Select the action that you wish to
make.

NOTE From this screen, tap the link Select the business card to
go to the Information Exchange settings.



Bluetooth® 8-9

Remote device services

Wireless serial port
Using a Bluetooth serial port is equivalent to using a physical cable serial
port connection between two devices. As with a physical connection, you
have to configure the application that will use the serial port.

To configure the Bluetooth Serial Port:

1. Tap  from the lower right corner
of the Today screen to display the
Bluetooth menu.

2. Tap Bluetooth Settings, then the
Serial Port tab.

3. Note the assigned Outbound
COM Port 6 and configure the
application that will use the
Bluetooth serial port to send data
to this port.

NOTE Refer to the application’s documentation for more information
about configuring your application’s Outbound COM port.

4. From the Bluetooth Manager My Shortcuts screen, open the Bluetooth
Serial Port connection to the remote device.

5. Send/receive data from the application.
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Dial-up networking
The Dial-up Networking feature allows you to connect to a rmeote
computer through a phone line. Once connected, you can browse the
Internet, check/read emails, etc.

NOTE The remote Bluetooth device that will provide the Dial-up
Networking service should have access to a telephone
system, either a hard-wired or a cellular connection, and
capable of answering a call.

Devices that may provide a Dial-up Networking service:

• Bluetooth-enabled cellular telephones

• Bluetooth-enabled desktop computers attached to a telephone system

• Bluetooth modems

To use Dial-up Networking:

1. Create a connection to the device that will provide telephone access.
See the section “Bluetooth connection wizard” on page 8-7.

2. Tap  , then the Bluetooth Manager from the Start menu.

3. In My Shortcuts screen, tap and hold the Dial-up Networking
Connection shortcut, then select Connect from the pop-up menu.

4. On the first Bluetooth: Dial-up Connection screen, double-tap New
Connection... OR select New Connection then tap OK.

5. Key-in the following informatin on the second Bluetooth: Dial-up
Connection screen:

• Name for a connection

• Country code (if dialing outside the default country setting)

• Area code (if dialing outside the default area code setting)

• Phone number to be dialed

6. Tap  OK.

7. Enter the required information on the succeeding screens to complete
the connection process.

8. When the connection is active, open a web browser from the device.
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Bluetooth file explorer
The Bluetooth File Explorer appears automatically after a file transfer
connection is established.

This service feature allows you to do the following operations:

• Navigate the directory structure of the remote device

• View the files and folders on the remote device

• Create new folders on the remote device

• Send files to, and copy or get  files from the remote device

• Delete files from the remote device

NOTE The file operations on the remote device are limited to the
configured FTP root directory and sub-directories of the
remote device.

The Bluetooth File Explorer also allows you to set a folder in your device
for receiving inbound files. You may configure this folder for each of your
connection shortcuts. See the section “To set a local folder” on page 8-13.

Bluetooth File Explorer menus

File Send a File...
Create a Folder
Get
Delete

Tools Set Local Folder
Refresh

To change the remote device folder:

1. To move down in the directory structure of the remote device, tap the
New Folder from the main window of Bluetooth File Explorer.

2. To move up in the directory structure of the remote device, tap the
down-arrow to the right of the currently selected folder and select the
New Folder from the drop-down list.
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To create a folder on the remote device:

1. Select the folder in which you wish to place the new folder.

2. From the File menu, tap Create a Folder.
3. Enter a name for the new folder while the default name New Folder is

highlighted.

To send a file to the remote device:

1. From the File menu, tap Send a File... to display the Open screen.

The Open screen includes the following:

Folder - tap the down-arrow and select the folder that contains the file
you wish to send

Type - default and only option is “All Files (*.*)

A list of files in  the selected folder - tap a file that you wish to send

Cancel button - abort the Send a File... operation

2. Tap your desired operation.

The file that you selected is automatically sent when tapped, after
which the Bluetooth File Explorer re-appears.

To get a file from the remote device:

1. Select the folder containing the file.

2. Tap the file that you wish to get or copy.

3. From the File menu, tap Get.

OR

Tap and hold the desired file and select Get from the pop-up menu.

The file is copied to the local folder listed in the Local Folder field at the
bottom of the screen.

To delete a file from the remote device:

1. Tap the file that you wish to delete.

2. From the File menu, tap Delete.

3. Tap OK in the confirmation dialog box.

OR

Tap and hold the desired file and select Delete from the po-up menu.
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To set a local folder for incoming files:

1. From the Tools menu, tap Set Local Folder.
2. Use the drop-down menu at the top of the screen to go to your desired

folder.

3. Tap OK to return to the main screen of Bluetooth File Explorer. You will
see the Local Folder field is updated to reflect the new folder selection.

NOTE The Local Folder information is associated with the currently
open shortcut and is saved with the active profile. You can
separately configure your Local Folder for each connection
shortcut.

To refresh the list of displayed files and folders on the remote device,
simply tap Refresh from the Tools menu.
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Send via Bluetooth
You can conveniently send your Pocket Outlook contacts, calendar items,
and tasks individually or collectively to the remote device via Bluetooth.

To send data via Bluetooth:

1. Tap   , then either Contacts,
Calendar, or Tasks.

2. Highlight an item that you wish to
send to the remote device.

3. Tap and hold the item, then tap
Send via Bluetooth from the
pop-up menu.

OR

Tap Tools from the command bar,
then select Send via Bluetooth.

4. On the Select a Bluetooth Device
screen, tap the name of the
destination, then tap OK.
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Dial via Bluetooth
The Dial via Bluetooth option allows you to select a contact from the
Pocket Outlook contacts list, and have your paired cell phone dial the
contact’s phone number. If a contact has more than one phone number,
select the number that you wish to dial. You may also modify a phone
number before you dial.

To dial via Bluetooth:

1. From the Pocket Outlook Contacts screen, tap and hold a contact and
select Dial via Bluetooth.

2. If your device is paired with more than one cell phone, or if a phone is
not yet selected, tap the phone icon next to Select a phone, and
choose the phone that you wish to use.

3. Select the number that you wish to dial, then tap Dial Number.
4. To modify the number, tap Edit Number and make your desired

changes. Tap OK to return to the previous screen.

NOTE If you modify a phone number, a dialog box appears with an
option to save or to discard the modification.

5. Tap Dial Number.
After the number is sent to the cell phone, the connection on the
device is closed.

After the cell phone completes the dialing process, you can use the
use the phone the normal way.
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Bluetooth Personal Area Network
A Bluetooth personal area network is a private, temporary, ad-hoc network
of up to eight (8) devices. A Bluetooth personal area network allows you to
easily exchange information that normally requires a TCP/IP network.
Most chat utilities, multi-player games, etc. are fully functional in a
Bluetooth personal area network environment.

Bluetooth private area networks are subject to the same security settings
(service availability, authorization, authentication, and encryption) that
govern other Bluetooth communications.

One Bluetooth device must be the host of the personal area network.
Other Bluetooth devices join the network as clients. The host can accept
and reject clients on an individual basis.

To set up a Bluetooth personal area network:

1. From the Bluetooth Manager,
select New>Connect> Join a
personal network. Tap Next.

2. On the wizard screen, select Host
a personal network, then tap
Next.

3. Add remote devices to the
Bluetooth personal network, if
desired.

a. Tap the Add button and select
the device that you wish to
add.

b. Add other devices, if desired.
There can be up to eight
devices, including the host.

4. After adding devices, tap OK to
complete the setup and close the
wizard.

NOTE Adding devices is optional. You do not have to add devices to
the personal network while configuring the host. You can let
other devices join the personal network later.
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To join a personal network:

1. From the Bluetooth Manager,
select New>Connect>Join a
personal network. Tap Next.

2. On the wizard screen, select Join
a personal network, then tap
Next. The Bluetooth browser
appears.

3. Select the host of the personal
network, then tap Next to
establish a connection to the
personal area network.

If you are asked to enter the IP
network settings, select Use
server-assigned IP address,
then tap OK.
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Accessing Wireless LAN
The Wireless LAN icon on your Today screen allows you easy access to
the Wi-Fi (Wireless Fidelity) feature on your device. Tapping the icon
displays a menu that allows you to:

• turn Wireless LAN on or off

• show the Wireless LAN info

• change the ASUS Settings

NOTE You may not use Bluetooth® and
Wireless LAN simultaneously. If
Bluetooth is turned on, the
Wireless LAN menu is grayed
out. You need to turn off
Bluetooth before you can turn on
Wireless LAN.

Using Wireless LAN

Turning on Wireless LAN

To turn on Wireless LAN:

1. Tap the  icon on the command bar.

2. Tap the option Wireless LAN ON. The
system automatically scans for all the
available wireless networks.

Wireless LAN icon
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3. From the list of detected wireless
networks, select a wireless network to
which you wish to connect your
device.

4. Select either The Internet or Work for
the network to connect your device.

5. Tap Connect.

Configuring Wireless Networks

To configure a wireless network:

1. After selecting a network to connect
your device, tap Settings instead of
Connect.

2. Make your desired changes to the
available networks on the list.

3. Tap OK when done.
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Wireless LAN configuration
Display the Wireless LAN information
screens by tapping the  icon, and
selecting Wireless LAN Info from the
menu.

To configure a network adapter:

1. Tap the Network Adapters tab.

2. Make your desired changes to the
available adapters on the list.

3. Tap OK when done.
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IP Address Configuration
This page shows the IP address details
and allows you to renew the IP address
when DHCP is used.

Pressing the Renew button forces the
Pocket PC device to refresh its server-
assigned IP address. The process may
take several seconds while the system
updates the IP information.

Wireless LAN Card Status
This page includes fields that display the current state and link information
of your Wi-Fi device, and allows you to re-scan the available Access
Points (AP) when necessary by tapping the Rescan button.

The Rescan button allows you to search for all available access points
ad-hoc networks in the profile. If your link quality or signal strength is poor,
you can use re-scanning to push the radio off a weak AP and search for a
better link with another AP. The re-scanning process may take a while.

State

This field shows the Wi-Fi connection status.

• Connected - the station is associated with
one wireless LAN device. This status also
indicates the MAC address of the device.

• Scanning - the station is attempting to
authenticate and associate with the
specified access point.

• Disconnected - a previous link existed but
no beacon was received. The connection
to the adapter is terminated.

• Disabled - the Wi-Fi device radio is turned
off.

• Not available - cannot obtain the Wi-Fi status; requires turning Wi-Fi on.

• Unknown - the Wi-Fi device is in an unknown state.



9-6 Chapter 9

Icon WEP status

none WEP disabled, no encryption

WEP disabled but encryption is required.
This status requires you to input the correct network key.

WEP enabled, data is correctly encrypted/decrypted.

WEP enabled but failed to enrypt/decrypt data.
This status requires you to input the correct network key.

Ad-hoc mode, WEP disabled.

Ad-hoc mode, WEP enabled.

The following table describes the WEP status icons that you may see on
your screen while on the Wireless LAN Card Status screen.

ESSID

This field shows the Extended Service Set Indenfier (ESSID) to which the
wireless device is connected. The text on this field is usually an
unreadable alphanumeric string.

BSSID

This field shows the Basic Service Set ID (BSSID) to which the wireless
device is connected. In ESS mode, this is the MAC address of the access
point to which your device is connected.

Current Channel

This field shows the radio channel that the Wi-Fi device is currently using.

Data Rate

This field shows the data rate that the Wi-Fi device is currently using.

Link Quality

This field shows the signal quality level between the Wi-Fi device and the
access point to which the device is currently connected.

Signal Strength

This field shows the signal strength level between the Wi-Fi device and the
access point to which the device is currently connected.
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Site Survey
This page allows you to search for
available wireless networks near your
device. Tap the Search button to scan all
available wireless networks and display
the results on your screen.

ESSID

This column shows the Extended Service
Set Indenfier (ESSID) of the wireless
network found in the search.

BSSID

This column shows the Media Access
Control (MAC) address of the access point, or the Basic Service Set ID
(BSSID) in an ad-hoc mode.

CH

This column shows the channel used by the wireless device.

Signal

This column shows the Received Signal Strength Indication (RSSI)
transmitted by each wireless network. This information is helpful in
determining which network you wish to associate your device. This signal
is normally represented by a dBm value.

To associate with one of the detected wireless networks:

1. Tap-and-hold on a wireless network entry, then tap Connect on the
pop-up menu.

NOTE Another way to connect is by tapping twice on the entry.

2. If the wireless network that you selected is on the profile, your device
will try to connect to the wireless network automatically without asking
you for additional information. Otherwise, input the required
information.

3. After you have entered the required information, tap OK. The wireless
network is then added to the profile, and your device will try to connect
to it.
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The following table describes the status icons that you may see on your
screen while on the Site Survey screen.

Icon Status

Access Point (AP)

Access Point with WEP enabled

Access Point currently connected

Access Point with WEP enabled currently connected

Ad-hoc network

Ad-hoc network with WEP enabled

Ad-hoc network currently connected

Ad-hoc network with WEP enabled currently connected

Profile Configuration
This page shows the detailed information
hidden behind the wireless management
mechanism of Pocket PC 2003, and
allows you to change the profile settings
of a selected wireless network.

The profile-based mechanism built-in the
Pocket PC 2003 conveniently allows your
device to connect to or switch between
several wireless networks using the
pre-configured profile settings, while
activating, roaming, or re-scanning the
Wi-Fi device.

The Refresh button allows you to keep the profile list up-to-date. When
you tap this button, the profile setting is immediately read from the system
and displayed on the screen.

CAUTION If you made changed the profile settings, make sure to save
the changes before tapping the Refresh button.
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ESSID

This column shows the Extended Service Set Indenfier (ESSID) used in
the profile entry.

Connects to

This column shows which network your device is connected, Work or the
Internet.

Pop-up menu items

Item Action

Move Moves the selected entry to a specified location

Edit Edits the selected entry. A profile edit window appears
and allows you to modify the settings for the entry.

Delete Deletes the selected entry from the profile.

Add New Profile Adds a new entry to the profile. A profile window appears
and lets you add and input the settings for the new entry.

Apply Change Applies all the changes you made and saves them to
the profile in system. Make sure to perform this action
after you have made your desired changes.

NOTE While configuring your settings in the Profile Configuration
page, you may also see icons that indicate the connection
status of your device. Refer to the table on page 9-8 for the
description of the icons.

To edit a wireless network profile:

1. Tap-and-hold on a wireless network
item and select the Edit option from
the pop-up menu, or simply tap twice
on the target entry to launch the Edit
menu.

2. Make your desired changes.

3. Tap OK when done.
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Statistics
This page displays the statistics of your
Wi-Fi device.

Tx Packets

This field shows both the current and
accumulated packets the Wi-Fi device has
transmitted.

Tx Bytes

This field shows both the current and
accumulated bytes the Wi-Fi device has
transmitted.

Times of Retry

This field shows the accumulated number of packets that were
successfully transmitted after retries.

Discard

This field shows the accumulated number of discarded transmit requests.

Rx Packets

This field shows both the current and accumulated packets the Wi-Fi
device has received.

Rx Bytes

This field shows both the current and accumulated bytes the Wi-Fi device
has received.

Decrypt Error

This field shows the total number of received packets that failed to decrypt.

FCS Error

This field shows the total number of received packets with incorrect CRC
value.
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Power Management
This page displays the statistics of your
Wi-Fi device.

Enable Power Saving

Check this box to enable the power
saving mode on the Wi-Fi device. Disable
(uncheck) this feature for better system
performance.

Automatically turn off Wi-Fi

• if not connected for

When this box is checked, your Wi-Fi
device automatically turns off if it
cannot connect to any wireless network after a specified time period.

• if not used for

When this box is checked, your Wi-Fi device automatically turns off if it
does not transmit or receive any data for a specified time period. This
feature saves system power especially when you are browsing on the
Internet reading web page contents rather then downloading data.

About
This page displays the Wi-Fi utility and
driver version information of your Wi-Fi
device.

For updated product information, technical
support, and downloads, visit the ASUS
web site at http://www.asus.com.
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WiFiME
WiFiME is a program built-in your Pocket PC device that makes wireless
networking even more convenient. This program allows you to turn on the
Wireless LAN (Wi-Fi) feature on your device, and continuously monitor
your wireless link status through the indicator icon on the task bar. The
WiFiME pop-up menu provides you quick and easy access to the Wi-Fi
configuration (WiFiCfg) utility if you wish to configure the wireless LAN
settings, or view configuration information.

To turn on Wireless LAN and launch the WiFiME program:

1. Tap  >Programs >ASUS
Programs.

2. Tap the WiFiME icon .

Pop-up menu
To display the WiFiME pop-up menu,

simply tap the WiFiME indicator   on
the task bar.

Wireless Info

This item shows the Wireless page of the
WiFiCfg.

Site Survey

This item shows the Site Survey page of
WiFiCfg.

Profile Info

This item shows the Profile page of WiFiCfg.
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IP Info

This item shows the IP Address Configuration page of WiFiCfg.

Rescan

This item prompts the Wi-Fi device to re-scan (search for) all available
access points (AP) or ad-hoc networks in the profile.

Radio off

This item turns off the radio of the Wi-Fi device.

About

This item shows the Wi-Fi utility and driver version information of your
Wi-Fi device.

Hide WiFiME

This item gives you an option to temporarily remove the WiFiME icon from
the task bar.

WiFiME task bar icons
The following describes the WiFiME indicator icons that you may see on
the task bar.

Icon Link Quality WEP Decryption result

Excellent Disabled —

Good Disabled —

Fair Disabled —

Poor Disabled —

Excellent Enabled Correct

Good Enabled Correct

Fair Enabled Correct

Poor Enabled Correct

Excellent Enabled Fail

Good Enabled Fail

Fair Enabled Fail

Poor Enabled Fail

Not linked — —

Ad-hoc network — —
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Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

1) This device may not cause harmful interference, and

2) This device must accept any interference received, including interference that may cause
undesired operation.

This device and its antenna must not be co-located or operating in conjunction with any other
antenna or transmitter.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
manufacturer’s instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital
apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

WARNING! The use of shielded cables for connection of the monitor to the
graphics card is required to assure compliance with FCC regulations.
Changes or modifications to this unit not expressly approved by the
party responsible for compliance could void the user’s authority to
operate this equipment.
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UL Safety Notices
Required for UL 1459 covering telecommunications (telephone) equipment intended to be
electrically connected to a telecommunication network that has an operating voltage to ground that
does not exceed 200V peak, 300V peak-to-peak, and 105V rms, and installed or used in
accordance with the National Electrical Code (NFPA 70).

When using the Pocket PC, basic safety precautions should always be followed to reduce the risk
of fire, electric shock, and injury to persons, including the following:

• Do not use the Pocket PC near water, for example, near a bath tub, wash bowl, kitchen sink
or laundry tub, in a wet basement or near a swimming pool.

• Do not use the Pocket PC during an electrical storm. There may be a remote risk of electric
shock from lightning.

• Do not use the Pocket PC in the vicinity of a gas leak.

Required for UL 1642 covering primary (nonrechargeable) and secondary (rechargeable) lithium
batteries for use as power sources in products. These batteries contain metallic lithium, or a lithium
alloy, or a lithium ion, and may consist of a single electrochemical cell or two or more cells
connected in series, parallel, or both, that convert chemical energy into electrical energy by an
irreversible or reversible chemical reaction.

• Do not dispose the Pocket PC battery pack in a fire, as they may explode. Check with local
codes for possible special disposal instructions to reduce the risk of injury to persons due to fire
or explosion.

• Do not use power adapters or batteries from other devices to reduce the risk of injury to
persons due to fire or explosion. Use only UL certified power adapters or batteries supplied by
the manufacturer or authorized retailers.

Replaceable batteries
If an equipment is provided with a replaceable batterym and if replacement by an incorrect type
could result in an explosion (e.g. with some lithium batteries), the following applies:

– if the battery is placed in an OPERATOR ACCESS AREA, there shall be a marking close
to the battery or a statement in both the operating and the servicing instructions;

– if the battery is placed elsewhere in the equipmen, there shall be a marking close to the
battery or a statement in the servicing instructions.

The marking or statement shall include the following or similar text:
CAUTION

RISK OF EXPLOSION IF BATTERY IS REPLACED
BY AN INCORRECT TYPE.

DISPOSE OF USED BATTERIES ACCORDING
THE INSTRUCTIONS

Compliance is checked by inspection.

Operator access with a tool
If a TOOL is necessary to gain access to an OPERATOR ACCESS AREA, either all other
compartments within that area containing a hazard shall be inaccessible to the OPERATOR by the
use of the same TOOL, or such compartments shall be marked to discourage OPERATOR access.

An acceptable marking for an electric shock hazard is        (ISO 3864, No. 5036)

Equipment for restricted access locations
For equipment intended only for installation in a RESTRICTED ACCESS LOCATION, the
instalation instructions shall contain a statement to this effect.
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